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Preface

When I was a child, I experienced the loss of a friend of the family due to a traffic
accident. I witnessed from up close how it tormented the people that were left
behind. Since that moment, traffic safety is very close to my heart. I even had the
opportunity to turn this passion into a career. After almost ten years of working
at De Lijn, I started working with engineering consultancy company Sweco three
and a half years ago, were I joined the Traffic & Mobility team. Not much later, I
had the honour to become the project leader of an important traffic safety project
of AWV, the Flemish governmental agency for Roads and Traffic. In this project,
a large number of problematic locations with regard to traffic safety are analysed
and improvements are proposed. These improvements are solely infrastructural
improvements. It gives me a great feeling of satisfaction when a suggested
solution is implemented in the field. However, I must admit that I am even more
interested in the human factor of traffic safety and the effect of human behavior
on road safety. As a father of two children, aged 7 and 11, the traffic safety of
children is a subject that is very dear to me. My goal therefore was to complete a
thesis that addresses a concrete, societally relevant traffic safety problem related
to young people in a solution-oriented manner.

It is my honest opinion that I have succeeded in achieving this goal.

During the period in which I was looking for such a concrete, societally relevant
traffic safety problem, I saw a video on social media of a young Flemish cyclist
who miraculously survived a collision with a train, which occurred after he
slalomed through the closed barriers of a railway crossing. In the weeks that
followed, the problem of unsafe behavior at railway level crossings was frequently
reported in the media and attracted my attention. It seemed like the subject had
chosen me.

When thinking of a possible intervention to tackle this problematic behavior, my
attention initially fell on applications of Virtual Reality. When it turned out that this
was not possible within the available time and budget, I happened to come into
contact with Roy Kunnen, who a few years ago was the victim of an accident with
a train, in which he lost three of his four limbs. Roy has since given lectures on
the subject in schools. After an initial short contact with him he appeared willing
to cooperate. Once again the refined version of my subject seemed to have chosen
me.

I am utterly satisfied that the study shows a positive effect, also in the long run,
of the live testimonial. I hope that the findings, propositions for further research
and the recommendations can be picked-up and implemented and this thesis can
make a difference.

I owe a lot of acknowledgement to a lot of people, without whom this thesis would
not have come about. First of all, I would like to express my sincere thanks to
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Roy Kunnen for his willing cooperation. His courage, positivity and sense of humor
have been an inspiration throughout my thesis work.

Next, I would like to thank my promotor prof. dr. Janssens and co-promotor prof.
dr. Ariane Cuenen for their extensive knowledgeable and dedicated feedback
during the process of writing this thesis. Thanks also to mrs. Nadine Smeyers for
the clear and prompt advice on the administrative side of thesis.

I would also like to send words of thanks to the principals and personnel of
Humaniora Kindsheid Jesu (HKJ) for their extensive and willing cooperation during
the research process: mr. Sebastian Braecke, mr. Werner Nevels, mrs. Ann Oris,
mr. Kurt Vanbockrijck and mrs. Sara Coels. I am also indebted to the students of
HKJ, who, as members of the experimental group, were willing to attend a
testimonial and complete up to three surveys.

I would also like to express my gratitude to mrs. Christel Thijs, mrs. Sara Jehaes
and mrs. Katrien Slegers and all students of the Instituut voor Katholiek Secundair
Onderwijs (IKSO) for the willingness to participate in the study as a control group
by spreading and completing up to three surveys without the upside of the
opportunity to attend a testimonial.

Furthermore, I would like to show my appreciation to mr. Paul Vanhoudt and mrs.
Daisy Molemans from WICO Neerpelt, for their enthusiasm to cooperate in the
pre-test of this study.

A word of thanks also goes out to the people at Infrabel (mrs. Annelies De Keyser
Annelies, mr. Gaetan Van Overmeiren and mr. Vincent Godeau) to prof. prof. dr.
sc. Danijela Bari¢ and prof. dr. Ruiter, for giving their valuable insights that helped
me to choose the right topic, target group, research method and type of
intervention.

Many thanks to my colleagues at Sweco that made it possible for me to pursue
my goal of getting my master’s degree in Transportation Sciences: mrs. Nele
Meex, mr. Stijn Van Pe, mr. Jeroen Bastiaens and mr. Jonathan Cops. Also thank
you to my colleague Elke, who helped me to get in contact with Roy.

Special thanks and lots of love to my nieces Kirsten Coels and Janne Vanderheyden
for testing and giving their feedback on the surveys.

Last but not least, I have a lot of gratitude towards my wife Sara and my children
Liam and Emma. Thanks a lot for you understanding and support during the many
hours and days that dad sat working behind his desk and had less time to spend
with you. Know that I am incredibly much looking forward to making this up to
you guys. I love you all immensely.

To my dad in heaven: thank you for giving me the most precious lesson in live: to
never give up, no matter how though the battle may seem. I miss you.



Summary

Dangerous behavior in the vicinity of railway crossings is a significant problem in
Belgium. According to the data of Infrabel, 55 people lost their lives and 41 got
seriously injured in railway crossing incidents between 2012 and 2022. In addition
to the physical and mental impact on victims, their families and friends as well as
on railway personnel, railway crossing incidents were the cause of many minutes
of delay on the Belgian rail network in 2022. In the past months, this traffic safety
issue has received a lot of attention in the Flemish media.

Despite the infrastructural interventions for which Infrabel makes a great effort,
the number of incidents and victims remains more or less stable leading to the
conclusion that behavioral interventions should be included into the solution mix.
These should be targeted to younger people, as they are (together with the
elderly) disproportionally represented in pedestrian-train collisions. Based on
previous studies, the target group of Flemish students in the second and third
grade of secondary schools is established.

The type of intervention that was examined were testimonials. More specifically,
a comparative study of the effect of a scalable, online video testimonial and a
testimonial in person, was conducted. For this purpose, contact was made with a
victim of a train accident, who lost three of his limbs in the accident and who gives
lectures about his experiences, mainly in schools. For this study, the victim was
asked to make a three-part video testimonial in which he tells his story in a
comparable manner as in the live testimonial.

A longitudinal control group experimental study design was adopted to measure
change in attitudes and behavior in traffic in general and at railway crossings in
specific and the impact of live and video testimonials. The results of a pre-test,
which was performed before the experimental group was confronted with the
testimonials, are compared with the results of two post-tests, one of which was
performed directly after the testimonials and the other one month after. The
control group received the pre- and post-tests surveys but not the intervention.
Both the live and video testimonial were offered to selected students in the 2™
and 3™ grade of a secondary school in Hasselt, while the control group involved
students from a secondary school in Hoeselt.

Four main analyses were performed. First of all, exposure to railway crossings and
attitudes and behavior with regard to traffic safety in general and at railway
crossings in specific are examined, using a dataset of 763 second and third grade
secondary school students.

In this analysis, it is found that a lot of students are exposed to railway crossings,
pointing out the importance of good education on railway crossings. Almost eight
out of ten respondents are exposed to a railway crossing when going to school,
on other occasions than travelling to school or both. Almost four out of ten times
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this exposure happens by foot, by bike or by moped, both for school as for non-
school travel. More than one third of those who cross a railway crossing on their
way to school do so every day or nearly every day. Nearly half of the respondents
live within one kilometre of a railway crossing.

Risky behavior is quite common. More than 5% of the students don’t find it
dangerous to cross a railway crossing when the red lights are flashing and the
barriers are completely closed. Only 45.2% consider this very dangerous.
Furthermore, 3% of the students indicate they have done it more than once a
week in the past 6 months and over 13% indicates that it is likely or very likely
that they will be doing it in the future.

The situation is even worse for risky behaviors when the barriers are opening or
closing and for risky behaviors that cause distraction, such as using a smartphone
or wearing headphones while crossing a railway crossing. There should be extra
focus on male students and 2" graders, as they are significantly less safe across
the board.

A second analysis, the search for factors that predict attitudes and behavior at
railway crossings, reveals that the most important predictors are attitude towards
traffic safety in general and past behavior at railway crossings, which is in line
with what is found in the literature. Socio-demographical variables are not good
at predicting attitudes, past behavior and behavioral intention at railway crossings,
except for grade (only for past behavior).

Next, in the evaluation of the live and video testimonials, it becomes clear that
students by far prefer live testimonials over video testimonials. They are perceived
as more credible, useful, interesting, important, informative, humorous and
shocking. Lack of time, budget and experience might have led to a less
professional and lower quality video testimonial leading to a significantly lower
cognitive and emotional impact.

Last, but not least: the effect evaluation shows that the live testimonial has an
immediate positive effect on both the attitude and the behavioral intention
towards risky behavior at railway crossings. Only the effect on behavioral intention
remains after a month. The video testimonial only has an immediate effect on
attitude and not on behavioral intention. After a month, there is no trace of the
effect on attitude. No significant effects were found for the control group for these
variables, neither in the short term nor in the long term.

It can be recommended to school boards to start providing students with
testimonials to change attitudes and behavioral intention at railway crossings. Live
testimonials are definitely recommended, because they appear to have a lasting
effect on behavioral intention. It has not been proven that video testimonials have
a similar effect. Further research should demonstrate whether high quality,
professional video testimonials can achieve this and if there is any effect on actual
behavior at level crossings, and not only on behavioral intention.
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1. Introduction

1.1 Problem statement

1.1.1 Risky behavior at railway crossings

Dangerous behavior in the vicinity of a railway crossing is a significant problem in
Belgium. According to the data of Infrabel, the organisation that is responsible for
the maintenance, expansion and modernization of the Belgian rail network, 55
people lost their lives and 41 got seriously injured in 6,858 railway crossing
incidents between 2012 and 2022 (Infrabel, 2023). In addition to the physical and
mental impact on victims, their families and friends as well as on railway
personnel, railway crossing incidents were the cause of 39,049 minutes of delay
on the Belgian rail network in 2022 (Infrabel, 2023).

In the past months, this traffic safety issue has received a lot of attention in the
Flemish media. In November of 2023, two deadly incidents occurred in the
province of East-Flanders with only a few days in between them. In the same
period, Infrabel spread some mind-boggling images of near accidents by Infrabel.
In April, a young cyclist that ignored the closed barriers at a railway crossing in
Wezemaal and died after being hit by a train. Based on media reports, the number
of fatalities due to accidents at railway crossings between September 2023 and
June 2024 can be estimated at 6, which is slightly more than the average of 5 per
year over the period 2012 and 2022. In 2022, however, there was an "annus
horribilis", in which 11 people died in a collision with a train at a railway crossing
(Infrabel, n.d.).

The problem was strikingly demonstrated in a tv interview on safety near railway
crossings with a spokesperson of Infrabel in the Flemish current-affairs
programme Ter Zake on December 4%, 2023. During the recording of the
interview, multiple people crossed the railway crossing, of which two were caught
on camera (VRT NWS, 2023).

On January 1%t 2023, Belgium had 1,630 railway crossings. Since 2005, Infrabel
has already abolished 442 railway crossings (Infrabel, 2023). Furthermore,
infrastructural and technological enhancements, such as tripping mats and
cameras near the tracks, are being operationalised to prevent and detect
dangerous behavior at railway crossings (Infrabel, 2023).
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1.1.2 The importance of behavioral interventions for young people

Despite these infrastructural interventions, the number of incidents and victims
remains more or less stable, leading to the conclusion that behavioral
interventions should be included into the solution mix. Infrabel has set up several
awareness-raising campaigns and educational programs, some of which are
specifically aimed at children and adolescents (Infrabel, 2023). Examples are
theoretical courses on railway safety and the escape game Rail Codes.

This is no coincidence, as research shows that younger and older pedestrians are
disproportionally represented in pedestrian-train collisions (Freeman et al., 2015).
A study among 1000 Belgians living near a railway crossing and/or occasionally
travelling by train, performed in 2018 by GfK (Gesellschaft fiir Konsumforschung)
at Infrabel’s request, leads to the same conclusions with regard to younger people
(Infrabel, 2019). In the age group of 15- to 24-year-olds, 5.48% indicated that
they had crossed a railway crossing while the red lights were flashing and the
barriers were fully closed at least once every two months in the past 6 months,
compared to 2.83% of the total sample. The difference is not significant, probably
because of a too low number of respondents in this age category. However, when
it comes to crossing a railway crossing when the red lights are flashing but the
barriers are not yet fully closed and when a train had already passed but the
barriers are not fully open yet or de red lights are still flashing, the difference is
significant (respectively 90.28% versus 96.01% for the total sample and 90.16%
versus 96.57% for the total sample did seldom or never dot it in the past 6
months).

GfK performed a segmentation of the total sample in a humber of segments,
according to the behavior and attitude with regard to imprudent behavior in the
vicinity of railway crossings. In the segment of Dangerous Doers, which are
defined as people that are aware that most of the risky behaviors are dangerous
but do not view their own behavior as dangerous, 15- to 24-year-olds are
significantly overrepresented. 79% of the Dangerous Doers have been careless
near a railway crossing at least once in the past 6 months. (Infrabel, 2019).

1.1.3 The need for education and the rise of microlearning tools

Education is needed to change the attitudes and — more important - the behavior
of youth at railway crossings. There are already many types of interventions with
regard to dangerous behavior at railway crossings or rail tracks that are already
in use in Belgium. Most of them are provided by Infrabel: theoretical lessons on
safety rules and consequences of dangerous behavior, gamification, dramatic
videos, immersion and testimonials.
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Lessons about traffic safety in general and safety at railway crossings in particular
are mainly offered within the regular education system. However, it is not easy to
provide an extensive and repeated offering within the already busy learning
program.

A rise of microlearning tools can be witnessed in the educational system and in
society as a whole, as it saves time, can be used on the go and doesn’t need a
high level of concentration or a long attention span. However, it is not fit for large
amounts of (complex) information and for group interaction. There are many
different forms of microlearning tools, of which videos are the most popular,
especially for tutorials and demonstrations of new skills (Buljan, 2021).

In this study however, the focus is on video testimonials that can be used as an
intervention tool to prevent and correct dangerous behavior by young people at
railway crossings. These are videos in which victims, family members of victims,
train drivers and other railway personnel tell their story. However, research that
examines the effectiveness of these video testimonials appears to be scarce or
even non-existent.

1.2 Key findings from scientific literature

1.2.1 Risky behavior at railway crossings

Risky behavior at railway crossings can be defined as crossing the tracks whenever
the red lights are flashing, the bell is ringing and/or the barriers are not completely
open.

This behavior could be the result of an error or a violation (Stefanova et al., 2018).
In the first case, defective safety infrastructure (barriers, flashing lights, bell,...)
may be the cause, but also an incorrect assessment of the situation or limited
knowledge of the rules and operation of a railway crossing (Stefanova et al.,
2018). Distraction or inattention which stems from engaging in secondary tasks,
is also mentioned as a risk factor in traffic situations, especially in busy or complex
ones (Young et al., 2018).

In the case of a violation, the behavior is intentional and has some benefits that
are greater than the perceived risk of being involved in a crash or being
sanctioned. Examples of perceived benefits are minimising effort (Read et el.,
2016), saving time, being socially accepted by important others and avoiding
being late (for example missing a train)(Stefanova et al., 2018). According to
Freeman and Rakotonirainy (2015) and Larue et al. (2019) more violations are
made than errors.
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The Theory of Planned Behavior, states that intention is the most important factor
for planned behavior. Intention is in turn influenced by 3 factors: attitude,
subjective norm and perceived behavioral control. The theory was an extension of
Ajzen's own Theory of Reasoned Action, adding the concept of perceived
behavioral control. A person's perception of his or her ability to perform a certain
behavior is therefore an important determinant of whether he or she will actually
perform that behavior. (Ajzen, 1985).

Theory of planned behaviour

Norm

Subjective

Perceived
Behavioral
Control

—_——— e e ——

Figure 1 - The Theory of Planned Behavior (Orzanna, 2015)

Different studies, such as Xu et al. (2017), indicate that violations are most of the
time not made out of a weighting of costs and benefits, but automatic and
routinized behavior, such as past experiences leading to habits and social
influences. Two important theories are mentioned by Stefanova et al. (2018):
Social Learning Theory and Social Comparison Theory.

The Social Learning Theory was developed by Albert Bandura of the Stanford
University in the seventies, and states that behavior is learned from the
environment through the process of observational learning (Bandura, 1977),
rather than approval from others (Cialdini et al., 1990). This is also supported by
observational research, such as the study conducted by Larue et al. (2018).
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Social Learning Theory

Figure 2 - The Social Learning Theory (Sutton, 2021)

In the Social Comparison Theory (Festinger, 1954), it is posed that people
evaluate their own social and personal worth based on how they compare to
others, when objective criteria are not available. However, when comparing
themselves to others, people tend to have more biased thoughts, underestimate
possible risks and overestimate the likelihood of positive experiences and are more
likely to engage in risky behavior. A possible explanation is that people perceive
themselves as more skilled than others (Stefanova, 2018). This is important in
the context of traffic safety in general and behavior near railway crossings in
specific.

Stefanova et al. (2018) found out that the behavior of pedestrians at railway
crossings depends on the situation, i.e., the status of the automatic safety controls
and the train’s visibility and position. Risk perception was the lowest and crossing
likelihood was highest when (pedestrian) lights were active and (pedestrian) gates
had started moving. However, past behavior, descriptive norms and perceived risk
of being involved in a crash were good predictors of the likelihood of risky behavior
for all scenario’s/situations.

As measuring risky traffic behavior is not easy, Stefanova at al. (2018) developed
an innovative method to measure crossing intentions and risk perceptions, in
which for several scenario’s, the participants reported their crossing likelihood,
perceived risk of being hit by a train and of getting sanctioned.
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1.2.2 Risky behavior of children at railway crossings

According to Freeman et al. (2015), both younger and older pedestrians are
overrepresented in train-pedestrian collisions. The study identifies “non-
perception of danger”, “impulsive risk taking” and “inattention” as the main
reasons for unsafe behavior of younger pedestrians near railway crossings. “Non-
perception of personal risk” was reflected in the belief that the risk of being hit by
a train applies less to them than to others. This is consistent with what can be
found in the relevant literature (Lapsey & Hill, 2010)(Steinberg, 2009).

With regard to “impulsive risk taking”, Steinberg (2009) indicates that the
tendency to engage in risky behavior increases from the age of 10 to a peak at
about the age 14 to 15, and then declines again. This may be due to an
underdeveloped prefrontal cortex, a higher level of sensation seeking, and the
ability to assess risks. The study of Freeman et al. (2015) confirms that the
respondents, aged 15 or 16 years old, did not acknowledge that their behavior
was risky, and the risky actions were impulsive and without cognition.

1.2.3 The effectiveness of microlearning tools to change attitudes and risky
behavior in traffic

Linder (2007) describes microlearning as “[...] what people are doing [...] when
they face the challenge to find new information and build new knowledge in new
networked digital media environments [...] as professional and private users
increasingly have to deal with small chunks of “microcontent”, loosely joined,
permanently changing, re-arranging and circulating.”

There is not much literature available that specifically deals with the effectiveness
of microlearning tools on traffic safety. The effectiveness of microlearning tools in
the healthcare sector is nevertheless mentioned in several articles, such as
Haghighat et al. (2023) and Zarshenas et al. (2022). Both studies make positive
conclusions, indicating positive effects on the promotion and retention of
knowledge, learners’ satisfaction, raising learning outcomes and self-efficacy.

Although the general concept of microlearning in the context of traffic safety is
not mentioned in literature, articles on the evaluation of some examples can be
found. Riaz et al. (2019) evaluate a e-learning platform that uses gamification to
improve traffic safety among elementary school pupils in Belgium. It contains a
self-study programme for approximately 15 minutes per week over a 5-week
period. Traditional learning methods seem to have a negative effect on student
motivation and engagement. In contrast, visual worlds and digital games have
very high engagement among children (McGonigal, 2011). The study Riaz et al.
(2019) conducted, showed that the e-learning program significantly improved
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pupils’ score in risk detection and risk management. When visual representations
of traffic situations were presented, pupils scored better in familiar surroundings
and situations then in unfamiliar ones.

1.2.4 The use of testimonials as an intervention for risky behavior near
railway crossings

Testimonials by traffic victims or their families and friends, are commonly used to
promote safe behavior in traffic. This is done by linking the story of a traffic
accident victim or their families, to the beliefs and behaviors of the audience
(Bojesen & Rayce , 2020)(Cuenen et al., 2016). The underlying idea is that a
testimonial will emotionally affect participants, thereby stimulating them to
cognitively reflect upon their own behavior as a road user (Cuenen et al., 2016).
Studies on the effect of this type of intervention are rather limited (Bojesen &
Rayce , 2020)(Cuenen et al., 2016).

Cuenen et al. (2016), present the findings of a study on the effect of a testimonial
programme in the third grade (5" and 6™ year, ed.) of secondary schools. The
focus is on the covered long-term effects of traffic accidents, rather than the more
obvious short-term effects, such as pictures of injuries. The results of this pre-
test/post-test designed study show that at baseline, female students were
significantly more road safety supportive than male students and students of
occupational education are significantly less road safety supportive than students
of general and technical education with regard to attitude, behavioral intention
and behavior. For subjective norm, they were only significantly less road safety
supportive than students of general education.

Moreover, the study shows that the short-term effect of the testimonial
programme (immediately after participation) on intentions, attitudes, social norms
and self-efficacy were rather small for general education and occupational
education students. Two months after participation in the program, the program
appears to have a major effect on male students on intentions, attitudes and social
norms, but not on self-efficacy. Students from general education had the highest
cognitive reception and students from occupational education had the highest
affective reception. The results indicate that both cognitive and affective reception
increase the effect of the program.

In (Cuenen et al. 2016) the effect on different variables were examined: attitude,
subjective norm, perceived behavioral control, behavioral intention and behavior.
Results indicate that the program had only a small to medium impact on most
socio-cognitive and behavioral variables. The effects depended on participants’
demographic profile, baseline values on the socio-cognitive and behavioral
variables and the cognitive and affective impact the program had on them.
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Bojesen & Rayce (2020) also indicate that the effect of the testimonial program
they examined was only small. The knowledge on risk factors was only slightly
affected and for the cycling behavior and seat belt use there was no effect at all.
The authors, nevertheless, point out some shortcomings of the study and suggest
some improvements. Firstly, the study should include behavior for which the base
line level is less high, as 99% of the participants already wore a seat belt at least
“almost always” before the programme, leaving not much space for improvement.
Secondly, further studies should make sure whether the ambassador is
representative for the target group, in terms of age, story and mode of
transportation.
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2 Objectives and research questions

2.1 Objectives

The three main objectives for this study are 1) to examine how serious the
problem of unsafe behavior at railway crossings is among young people and
therefore how great the need is for using testimonies as an intervention tool
(measurement of behavior); 2) to examine which variables predict attitudes and
behavior at railway crossings; 3) to carry out an evaluation of a live and video
testimonial, in order to find out how they are assessed by the participants (process
evaluation) and 4) to evaluate what effect these live and video testimonial have
on (socio-cognitive determinants of) the behavior of young people at railway
crossings (effect evaluation).

To reach this goal, the following partial objectives are established:

e To gain a good insight into the presence of (socio-cognitive determinants)
behavior in the target group, both for general road safety and for safety at
railway crossings in particular and to examine the presence of notable
differences between subgroups;

e To perform a (regression) analysis to get insight into the socio-
demographical and socio-cognitive variables that are able to predict
attitudes, past behavior and behavioral intention at railway crossings;

e To develop a video testimonial that can be presented to an experimental
group with the aim of increasing safe attitudes and behavior in traffic in
general and at railway crossings in specific;

e To organise a learning moment for the experimental group(s), in which they
are subjected to one live or multiple video testimonials;

e To conduct a process and effect evaluation of the live and video
testimonials, by performing one pre-test and two post-tests among two
experimental groups and the control group.

2.2 Key research questions and sub questions

Research questions that can be distilled from these research objectives. Key
research question and sub questions are formulated for each of the main
objectives.
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2.2.1 Measurement of (socio-cognitive determinants of) behavior in traffic in
general and at railway crossings in particular

The key research question for the measurement of behavior in traffic in general
and at railway crossings is:

“How serious is the problem of unsafe behavior at railway crossings among young
people?”

The following sub questions are defined:

e How safe is/are the (socio-cognitive determinants of) behavior of the target
group, for general road safety?

e Is there a significant difference in these/this (socio-cognitive determinants
of) behavior in traffic in general between subgroups based on gender, grade
and study domain?

¢ How safe is/are the (socio-cognitive determinants of) behavior of the target
group, for safety at railway crossings in particular?

e Is there a significant difference in these/this (socio-cognitive determinants
of) behavior at railway crossings between subgroups based on gender,
grade and study domain?

e How high is the level of exposure of youth in Flanders to railway crossings?

2.2.2 Search for factors that predict attitudes and behavior at railway
crossings

For the search for factors that predict attitudes and behavior at railway crossings,
the key research question is formulated as follows:

e “Which variables are able to predict attitudes, past behavior and behavioral
intention at railway crossings?”

To answer the key research questions, the following sub questions are defined:

o Which socio-demographical variables are able to predict attitudes,
past behavior and behavioral intention at railway crossings?

o Which socio-cognitive variables are able to predict attitudes, past
behavior and behavioral intention at railway crossings?
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2.2.3 Process evaluation

For the process evaluation, the key research question is formulated as follows:

“How do participants evaluate the presented live and video testimonials on
cognitive and emotional aspects and some qualitative elements and which format
do they prefer?”

To answer the key research questions, the following sub questions are defined:

o How do the members of the target group assess the presented live
testimonial on cognitive and emotional elements and some
qualitative elements, such as duration, clarity and performance of
the speaker?

o How do the members of the target group assess the presented video
testimonial on cognitive and emotional elements and some
qualitative elements, such as duration, clarity and performance of
the speaker? Is there a significant difference with the assessment of
the live testimonial?

2.2.4 Effect evaluation

The key research question for the effect evaluation is:

“Can the presented live and/or video testimonial help to change the (socio-
cognitive determinants of) behavior of the target group with regard to risky
behavior at railway crossings?”

The following sub questions are formulated to help answer the key research
question and fulfil the research objective:

¢ Can an effect of the live and/or video testimonial be observed immediately
after offering these testimonials to the respondents?

¢ Can an effect of the live and/or video testimonial be observed one month
after offering these testimonials to the respondents?

23



24



3. Methodology

3.1 Exploratory discussions with stakeholders

The first step of the research process was the exploration of the subject in the
form of conversations with those involved in the subject. The insights of two
important stakeholders in the problem of dangerous behavior of young people in
the vicinity of railway crossings were gathered: a secondary school and Infrabel.
A meeting was set up with the principal and the deputy principal of the secondary
school Humaniora Kindsheid Jesu, which took place on December 18%, 2023. A
follow-up meeting took place on February 22", 2024. Contacts with Infrabel too
place via e-mail, because of planning difficulties.

The goal of these discussions was to find out what to focus on, which knowledge
of the subject is already available and which insights would be valuable for the
stakeholders. For the secondary school, this meeting was also used to get alignhed
with respect to the possibilities and conditions for conducting the research at the
school, with the students being part of the sample.

In the meeting with the principals of Humaniora Kindsheid Jesu, the subject and
the approach of the research were presented. Next, the problem of dangerous
behavior at the railway crossing in the vicinity of the school (Paalsteenstraat) and
at the train station near the school (Kiewit Station) were discussed. At the
Paalsteenstraat, the problem does not seem to be that big, because before and
after school, a lot of people are waiting for the closed barriers by foot, on bikes or
in cars, causing a certain level of social control. At Kiewit Station, the
infrastructure was recently adapted (a pedestrian bridge with a broad staircase,
higher platforms), which discourages dangerous behavior. A dangerous behavior
that still takes place is standing too close to the rails, which can also lead to
accidents. The school is already active in raising awareness of the dangers near
railway tracks. When a student is caught breaking the rules, a notification is sent
to the parents.

The school was willing to participate in the research. However, attention should
be paid to practical feasibility. Students should miss as few lessons as possible. It
would be ideal if the intervention and necessary surveys could be performed within
one class period (50 minutes). Finally, attention was paid to possible side effects
of research on dangerous behavior at railway crossings, because it might “inspire”
some students and be a sensitive topic to others.

With Infrabel, a meeting was set up on January 15%, but this could not take place
because of planning issues and because, by the 15™ of January, the research
design for this study already seemed to be moving in a more or less final direction.
A discussion via e-mail revealed that Infrabel has only limited experience with
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evaluations of the effectiveness of the interventions they organise. After “The
Floor”, an awareness campaign that uses virtual reality, Infrabel systematically
sent an evaluation form to the participants. Teachers indicated that the action had
an effect and that the message was getting through. However, it was not known
whether this would enable long-term behavioral change. Behavioral studies were
also performed in the past; However, these were performed with a broader panel
than just young people. Infrabel also showed interest in evaluation the effect of
the escape game "“Code Rails” and their ready-made presentation with
testimonials.

3.2 Target group and sampling

In the Railspect study that GfK performed on behalf of Infrabel, the lowest age
group that was defined, was that of people between 15 and 24 years old. In
Cuenen et al. (2016), the focus was on students of the 3™ grade of secondary
schools. To maximize the alignment and comparability with these studies, the
target group of Flemish students in the second and third grade of secondary
schools is established. Flanders is chosen as a geographical scope, as it differs
largely from the other Belgian regions, such as Wallonia, which has a significantly
less dense rail network than Flanders. Education in Belgium is also organized at a
regional level.

The target group of this study can therefore be defined as Flemish 2" and 3™
grade students. To clarify, this concerns students in the 3™ to 7™ year of
secondary school.

The target population size is 315,529, according to the data of Departement
Onderwijs Vlaanderen of February 1t, 2024.

Table 1 - Distribution of the target population by grade and gender

Grade Total Male Female
2" grade 159,910 82,145 77,765
3rd grade 155,619 79,094 76,525
Total target population 315,529 161,239 154,290

For practical, timing and budgetary reasons, it is not possible to perform the
research on the total target population. For a population size of 315,529, a
confidence level of 95% and a margin of error of 5%, the minimum sample size
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should be 384 (Qualtrics Sample size calculator, 2023). However, this sample size
is only obtained in the ideal case. Also in the ideal case, the control group is about
the same size as the experimental group. In practice, the aim should always be
to obtain the largest possible sample size within the practical, timing and
budgetary possibilities.

The non-random sampling method of convenience sampling is used because of
practical reasons. As the target population of this study consists solely of
secondary school students, the research is done in the school context and during
school hours.

Two secondary schools are selected in the province of Limburg, as it is the province
in which Hasselt University is located and in which the Master student lives. The
criteria that were used for the selection of the schools are that they provide
education for the target group (2" and 3™ grades of secondary education) and
that the school is situated near a railway crossing (<400 m).

The secondary school Humaniora Kindsheid Jesu in the city of Hasselt, is chosen
as the school in which the experimental group is addressed. This was done
because of the size of the school, the Master student's familiarity with this school
and the central location. The school is located near a railway crossing, which is
located at 250 meters from the back entrance (Paalsteenstraat). There is also a
train station nearby (Kiewit Station, at 350 meters from the front entrance).

The school management selected classes in the 2" and 3™ grade, to whom either
the live testimonial (12 classes, 250 students) and video testimonial (11 classes,
251 students) would be presented. The total experimental group was thus larger
than the required minimum sample size of 384. This provided some margin for
absent students, cleaning of data, ...

A second school was selected as the school in which the control group was
addressed. Therefor, a GIS-analysis was performed. In QGIS, a layer with al the
secondary schools in Flanders and a layer with all the railway crossings in Belgium
were created. Around the secondary schools, a buffer of 400 meter was drawn.
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Figure 3 - Secondary schools (green dots) with 400-meter buffers and railway crossings
(pink dots) in Limburg

A visual check was then carried out to detect all secondary schools in Limburg for
which a railway crossing falls within the 400-meter buffer, as is the case in the
image below for a school in Pelt.
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Figure 4 - Visual check of presence of railway crossings (pink dots) in 400-meter buffer
around schools (green dots)

The following list of potential candidate school was obtained.

Table 2 - List of potential candidate schools for the control group

Name school Address Municipality
WICO Neerpelt Stationsstraat 74 3910 Pelt
Bovenbouw Sint-Michiel Diestersteenweg 3 3970 Leopoldsburg
Sint-Michiel Middenschool Diestersteenweg 11 3970 Leopoldsburg
Campus MAX Middenschool Stationsstraat 125 3980 Tessenderlo
Humaniora Kindsheid Jesu Kempische Steenweg 400 3500 Hasselt

Middenschool Kindsheid Jesu Kempische Steenweg 400 3500 Hasselt
Technisch Instituut Sint-Jozef Sint-Lambertuslaan 15 3740 Bilzen
GO! Atheneum Martinus Sint Martinusstraat 3 3740 Bilzen
Instituut voor Katholiek Bruiloftstraat 10 3730 Hoeselt
Secundair Onderwijs

These schools are then checked against the criteria of presence of the target group
(2" and 3™ grade). Also, Humaniora Kindsheid Jesu is deleted from the list as it
is already selected for the experimental group.

The following schools remain in the running.
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Table 3 - List of remaining potential candidate schools for the control group

Name school Address Municipality
WICO Neerpelt Stationsstraat 74 3910 Pelt
Bovenbouw Sint-Michiel Diestersteenweg 3 3970 Leopoldsburg
Technisch Instituut Sint-Jozef Sint-Lambertuslaan 15 3740 Bilzen

GO! Atheneum Martinus Sint Martinusstraat 3 3740 Bilzen
Instituut voor Katholiek Bruiloftstraat 10 3730 Hoeselt
Secundair Onderwijs

These schools were then contacted by telephone and the question was asked
whether the school wanted to participate in the study. For most schools, the
research did not fit into the planning and was considered rather burdensome. Two
schools were willing to collaborate: Instituut voor Katholiek Secundair Onderwijs
(IKSO) and WICO Neerpelt. Due to timing issues, the data collected at WICO
Neerpelt was not included in the analyses of this study.

At IKSO, 2" and 3™ grade students, in total 495 students, and their teachers were
informed about the study via the school’s communication tool in Smartschool. The
teachers then guided the students in completing the surveys. The total control
group was, like the experimental group, larger than the required minimum sample
size of 384. This, once again, provided a margin for absent students, cleaning of
data, ...

Finally, it was examined whether infrastructural works are planned on the railway
crossings in the vicinity of the selected schools. After all, Infrabel is continuously
working on making railway crossings in Belgium safer. It became clear that
Infrabel and the involved stakeholders have a vision for the different railway
crossings in Hoeselt, including those near IKSO. This vision involves the closing of
railway crossings and possibly replacing then with infrastructural alternatives,
such as a bridge or a tunnel. However, no dates have yet been set for the start of
the works (Infrabel, 2024).

3.3 Research design

A longitudinal control group experimental study design is adopted as it is the main
objective of this study to measure change in attitudes and behavior and the impact
and effectiveness of testimonials. To find an answer to the research questions, the
results of a pretest, which is performed before the experimental group is
confronted with the testimonial that needs to be evaluated (the intervention), is
compared with the results of two post-tests, one of which is performed directly
after the confrontation with the intervention and the other is performed one month
after the confrontation with the intervention. The control group receives the pre-
and post-tests but not the intervention. A double-control design, in which a second
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control group does not receive a pre-test, can identify and separate reactive,
maturation and regression effects. However, this second control group should be
more or less as large as the experimental group and the first control group, raising
the need for a large number of respondents even more. It was therefore decided
that a double-control design is not implemented.

3.4 Measuring instrument

In order to find answer to the established research questions, a measuring
instrument was developed, which would be presented to the members of the
target group. An online survey that could be completed on a smartphone, laptop
or tablet was preferred because of the convenience for the data collection,
processing and analysis of the data. The measuring instrument was developed in
Qualtrics.

The main survey, which is added in Annexe 1, was presented to both the members
of the experimental group and the control group and is the basis for the
measurement of behavior at railway crossings. It was somewhat adapted for later
phases of the study (the two post-tests) and for different target groups (live
testimonial experimental group, video testimonial group and control group).

Because the target group of this study consists of minors, it was necessary to
obtain permission from the parents of the respondents. A consent form was
drawn-up in an opt-out format and is attached to this report in Annexe 3.

3.4.1 Main survey for the measurement of (socio-cognitive determinants of)
behavior in traffic in general and at railway crossings in particular

The main survey starts with an introduction, in which the research topic is briefly
mentioned, and the most important term (railway crossing) is explained.
Furthermore, the voluntary basis and the assurance of the anonymity of the
respondents are emphasized and the estimated duration is stated. Instructions
are also given on how questions should be answered that do not fully apply to the
respondent's situation.

Respondents are then asked to provide a number of socio-demographic data, such
as gender, year of birth, name of the school, grade and study domain. Travel
behavior to and from school is also surveyed, including the main means of
transport and driving license possession (permanent or provisional and for which
means of transport).
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Next, some questions are asked about the respondents’ frequency of exposure to
railway crossings on the way to and from school and at other occasions, the mode
used when exposed to railway crossings and about the proximity of a railway
crossing to the place of residence (within one kilometre, 15 minutes walking or 5
minutes cycling). Furthermore, the respondent's experience with traffic fines (how
many times and for which violation) and traffic accidents (how many times and
type of location) is asked.

In the last part of the survey, a number of scales (five-point Likert) are used to
search for the socio-cognitive determinants of safe behavior in traffic in general
and near railway crossings in particular.

A sizeable set of 55 items was taken from Ceunen et al. (2016). It includes items
that attempt to measure the different concepts of Ajzen’s (1985) Theory of
Planned Behavior (attitude, subjective norm, perceived behavioral control,
behavioral intention and behavior) by asking the respondent's opinion on a
number of statements about (un)safe behavior in traffic, using an answer scale
ranging from “completely disagree” to “completely agree”.

To estimate attitudes, behavior and behavioral intention with regard to safety at
railway crossings, inspiration was gained from the Railspect study that GfK carried
out for Infrabel. Three different scales were added, assessing 7 unsafe behaviors
at railway crossings. These behaviors and the results obtained are explained in
detail in section 4.1.5.

Using a 5-point Likert scale, respondents were asked how dangerous these
behaviors were (attitude), how often they had performed this behavior in the past
6 months (past behavior) and how likely it was that they would do this behavior
in the future.

Finally, a set of 5 items was added, based on the way Feenstra et. al (2014)
attempts to measure self-efficacy. This is done in a relative way, where the
respondents have to compare their skills with those of their same-sex and same-
age peers on a scale ranging from much worse to much better, rather than giving
themselves an absolute score from very poor to very good. The items were
adapted to the specific context of railway crossings.

3.4.2 Additions and adjustment for the process and effect evaluation

For the process evaluation (the assessment of the live and video testimonials
immediately after they were presented) and the effect evaluation (the
examination of effects on the socio-cognitive variables of the safety of traffic
behavior immediately and a month after the testimonials), the main survey was
adapted. These adjustments differed between the experimental groups and the
control group.
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First of all, respondents were asked to enter the first two letters of their first name,
the first two letters of their mother's first name, their day of birth in two number
and their month of birth in two numbers. These questions were asked in order to
create a code that could be used to link the answers to the different surveys in
the different phases of the study, while guaranteeing the anonymity of the
respondents.

The adapted survey contained fewer socio-demographic questions (only year of
birth and school). This was done deliberately in order to keep the survey as short
as possible, while still collecting sufficient information that might help to link the
different surveys of the different phases.

The questions about travel behavior to and from school, exposure to railway
crossing, experience with traffic fines and traffic accidents were also no longer
asked.

An important addition for respondents in the experimental group were the
evaluation questions on the live and video testimonials (see also Annexe 2).

First, it was determined whether or not the respondent had been offered a
testimonial and which testimonial the respondent had been offered (live or video).
In case respondents indicated that they had seen the video testimonials, they
were asked how many of the 3 videos they had seen.

The evaluation of the testimonies itself was based on a 5-point Likert scale with
response options ranging from "completely disagree" to "completely agree". This
involved asking the extent to which the respondent agreed with statements about
cognitive aspects, such as credibility, usefulness, interestingness, importance,
informativeness, and emotional aspects such as shockingness, perturbation,
frighteningness, preference and some qualitative elements, such as duration,
clarity and performance of the speaker. Also, two open-ended questions were
added which asked what the respondent remembered most about the testimonial
and what the respondent would possibly add and/or adjust to the testimonial.

In the second post-test, the evaluation questions were omitted, except for the
question about what testimonial the respondents had received and the open
question about what they remembered most about the testimonial.

For the effect evaluation, the questions about the socio-cognitive determinants of
behavior in traffic in general and at railway crossings in particular were taken
verbatim from the main survey. Only the question about past behavior at railway
crossings was slightly adjusted because the question did not have to be asked
about the past 6 months, but about the past week or month (i.e., since the pre-
test). However, something went wrong when formulating the answer options,
more about which in chapter 6 Limitations and future research.
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3.5 Intervention

When looking at the interventions with regard to dangerous behavior in the vicinity
of railway crossings or rail tracks that are already in use in Belgium, they can be
divided into a few categories: theoretical lessons on safety rules and consequences
of dangerous behavior, gamification, dramatic videos, immersion such as Virtual
Reality and testimonials.

An example of gamification is Rail Codes, the escape game developed by Infrabel
(n.d.). Dramatic videos are for example videos of people crossing closed railway
crossings (Infrabel, 2014), videos of tests with crash test dummies (Infrabel TV,
2015) and videos in collaboration with a popular television soap in which a scene
is shown of a character being hit while crossing a railway crossing (Infrabel TV,
2019).

For this study, it was decided upon that the intervention that would be examined
would be testimonials: in person testimonials or videos in which victims of train-
related incidents or their family members, train drivers and other railway
personnel tell their story. More specifically, a comparative study of the effect of a
scalable, online video testimonial and a testimonial in person, is conducted. For
this purpose, contact was made with Roy Kunnen (www.roykandat.be), who was
involved in a train accident five years ago in which he lost three of his limbs. Roy
gives testimonials about his experiences, mainly in schools. In 2023 he was invited
to ten schools. Roy was asked to make 3 video testimonials in which he tells his
story in a comparable manner as in the live testimonial.

The live testimonial took place on March 11%" from 13:50 until 14:40 in the
auditorium of Humaniora Kindsheid Jesu before an audience of about 250 students
and about a dozen of teachers. The duration was initially set to 30 minutes, after
which the students had the opportunity to ask questions and go to their classroom
to fill in the post-test survey under the surveillance of a teacher. However, the
testimonial only finished after about 45 minutes, leaving no room for questions
and leaving the responsibility of filling in the second to the students themselves.
This will further be discussed in chapter 6 Limitations and future research.

The video testimonials consisted of three separate videos of about 10 minutes
(respectively 8, 11 and 10). They were filmed with a smartphone in Roy's living
room. In the videos Roy can be seen sitting on the sofa while he tells his story.
The videos were posted to a YouTube channel, where they were hidden except
from people who had the link. They were shown at three different times (March
12%, 13% and 14% always in the third period) to imitate the properties of
microlearning as closely as possible (providing short learning moments in a dosed
manner). They were shown in class on a smart board in the presence of a teacher.
Each video had a different topic. The first video gave an outline of the accident,
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the second video was about the time in the hospital and the third video was about
the rehabilitation process.

3.6 Analysis

The obtained data in the pre-test and the post-tests, was processed using SPSS
(IBM SPSS Statistics version 29.0.1.1 (244)) and was subjected to a number of
statistical analyses, which will be described in detail in the following paragraphs.
The analysis process, however, started with data cleaning and processing
(merging, recoding, quality controls).

3.6.1 Data cleaning and processing

Five datasets emerged from the data collection phase: the pre-test dataset, the
first post-test dataset for both the experimental group and the control group and
the second post-test dataset for the experimental group and the control group. A
number of cases were removed from this dataset in a first step: the test cases
that were filled in to test the survey before the actual launch, cases with wrong or
impossible answers, such as wrong school names, impossible birth years, double
cases, unfinished cases in which the respondent had not at least answered the
questions about the socio-cognitive determinants of traffic behavior, ...

In addition, an extra cleaning was performed on the first and second post-test
data sets. The cases were removed where the respondent indicated that he or she
had not witnessed any testimonial (120 out of 287 respondents). Presumably the
question ("Did you recently attend a testimonial at school by a victim of a traffic
accident involving a train?") was misinterpreted and watching the video
testimonial was not seen as attending a testimonial. Another explanation is that
the students in question were actually not offered any live or video testimonial,
but inquiries with the school show that this is virtually impossible. However, in the
second post test, the question about the attendance of a testimonial was
rephrased into “"Did you recently see a testimonial at school from a victim of a
traffic accident involving a train?” with the answer options * yes, in the form of a
lecture in the auditorium”, “yes, in the form of short videos” and “no”, leaving
little room for error. Still, 40 of 218 respondents answered “no”. Once again, the
school indicated that the surveys were only presented to respondents that
attended the live testimonial or watched the video testimonial. It was decided not
to remove these cases before merging and to see whether or not they could be
matched to a case in the first post-test dataset that did indicate whether the live
testimonial was attended, or the video testimonials were watched (see further).
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One final cleaning on the first post-test dataset, consisted of removing all cases
where respondents who indicated that they had seen the video testimonial said
that they had not seen all 3 videos. This concerned 17 cases.

The following table provides an overview of the datasets after cleaning and before
the merging process, which will be explained below the table.

Table 4 - Overview of the datasets after cleaning and before merging

Dataset Total # # live # video Total Total

cases testi- testi- experimental control
monials monials group group

Pre-test 763 0 0 462 301

Post-test 1 176 0 0 0 176

control group

Post-test 1 167 110 57 167 0

experimental group

Post-test 2 190 0 0 0 190

control group

Post-test 2 218 63 115 178 0

experimental group

The data analysis for the measurement of behavior at railway crossings would be
performed on the "pre-test" dataset (n=763), the data analysis for the process
evaluation on the "post-test 1 experimental group" dataset (n=167). For the effect
evaluation, the pre-test dataset had to be linked to the first and second post-test
datasets, whereby cases from the same respondent had to be matched to each
other to map the effects of the testimonials for these students.

To prepare the datasets for merging, the names and labels of variables were
provided with a suffix (_pre, _post, _post2) and it was ensured that all
corresponding variables from the data sets that needed to be linked had the same
name and label.

A two-step method was used to obtain the final data file on which the effect
evaluation was carried out. First, the post-test datasets of the experimental group
and the control group were merged using the SPSS function Data -> Merge Files
-> Add Cases. Only the evaluation questions about the testimonials, which the
respondents in the experimental group additionally received, could not be paired.

In the second step, the pre-test dataset and the complete post-test datasets
(containing both the cases for the control group and the experimental group
respondents) were linked together. This was done using the SPSS-function Data -
> Merge Files -> Add Variables. The previously mentioned code (see also
paragraph 3.4.2) was used as the Key Variable, which was composed of the first
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two letters of the respondent's first name, the first two letters of the respondent's
mother's first name, the two digits of the respondent's day of birth and the two
digits of the month of birth of the respondent.

To generate this code, a few more operations had to be done. First, the SPSS
function Transform -> Compute Variable and the formula UPCASE () were used to
ensure that all letters were capitalized. In addition, in the SPSS syntax, the
formula FORMATS numvar (n2) converted all 1-digit numbers into a 2-digit
number with a "leading zero", a zero at the beginning of the number (e.g., "1" -<
"01 "). By joining these letters and numbers in the SPSS-syntax with the Concate
formula CONCAT () a quasi-unique code was generated, while still ensuring the
anonymity of the students.

First, the pretest dataset (n=763) was linked to the dataset of the first post-test
(control group and experimental group combined, n=343). This already showed
that the merging process would be difficult: only 179 cases could be matched,
meaning 164 cases were lost (48%). Further research made it clear that the
biggest problem lay with the control group, where of the 176 cases, 120 could not
be matched (68%).

An extensive analysis of this problem revealed several possible explanations. It
seems that many respondents went through the questions related to the code too
quickly and thus did not read them carefully enough. After all, the questions were
clearly formulated (see also Annexe 1). In some cases, the student's and/or
mother's initials were given in place of the first two letters. Sometimes the first
two letters of the student's last name were given instead of the first two letters of
the mother's first name. At other times, only one letter was entered or even the
full name instead of just two letters. Sometimes it was just typographical errors,
including adding spaces before or after two letters or numbers. SPSS sees spaces
as a character. SPPS also has difficulty dealing with accents. These are seen as 2
letters (the letter and the accent) and because a maximum number of characters
was assigned to the code variable (8), the letters in some codes were incorrectly
truncated and merged with the other letters and numbers. Chapter 6 Limitations
and future research discusses this problem and its possible consequences in more
depth.

A number of actions were taken to detect some of these errors and correct them
in a substantiated manner: excess spaces were removed and accented letters
were converted to regular letters. In addition, codes that were similar were
searched for. This could, for example, concern codes where the day of birth and
the month of birth were the same and at least 1 of the 4 letters was similar. Excel
was also used for the search of similar codes using the VLOOKUP-function: the
lists of all codes were searched for an approximate similarity for any unmatched
codes in pre- or post-test. When a possible match was found, a check was made
on year of birth and school to see if it matched. The ultimately obtained list of
possible matches was then provided to the schools with the question whether they
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could check in the student data whether these cases could be linked to each other.
Confidentiality was fully respected: the school did not gain insight into the answers
that the individual students had given to the survey, and, on the other hand, the
personal data were not released to the researcher. When the schools confirmed
that there was a match, the codes were adjusted in the datasets.

In this way, when the pre-test was linked to the first post-test, 18 additional cases
were retrieved (7 from the live testimonial experimental group, 2 from the video
testimonial experimental group and 9 from the control group).

These actions were also applied in the second step of the merging process, where
the dataset obtained in the first step (the merged datasets with cases from the
pre-test and the first post-test, n=197) was merged with the dataset of the second
post-test (n=408, control group and experimental group combined).

Initially, only 68 cases could be linked, which represents only 35% of all cases in
the previously linked file. Implementing the actions provided little relief: only 9
additional cases were retrieved (3 from the live testimonial experimental group, 3
from the video testimonial experimental group and 3 from the control group).

As mentioned above, it was also important to check whether or not the 40 cases
in the 2" post-test, for which the respondents indicated that they were not
presented a testimonial, could be matched with a case in the pretest dataset and
the 15t post-test. This was not the case for any of these 40 cases, making the
search for a solution to this problem no longer necessary.

Table 5 provides an overview of the two merged datasets that were eventually
used for the effect evaluation.

Table 5 - Overview of the two merged datasets for effect evaluation

Dataset Total # # live # video Total Total
cases testi- testi- experimental control
monials monials group group
Prepostl 197 87 45 132 65
Prepost2 77 28 23 51 26

Both for the measurement of behavior and for the effect evaluation, the
respondents need to be assigned a score on each of the socio-cognitive variables
that determine (un)safe behavior in traffic in general and at railway crossings in
particular. Therefore, the items in the survey must be combined into variables.

In SPSS, the mean scores for each respondent on these variables are computed
with the function Transform -> Compute Variable and the formula MEAN (). First,
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however, the scores on some items must be reversed. This study assumes that
higher scores always imply a more road safety supportive view. It was checked
which items were formulated inversely, namely as an unsafe statement, attitude
or behavior. The items for which this was the case were reversed by using the
SPSS function Transform -> Data -> Recode into Different Variables.

For the items with regard to traffic safety in general, the grouping per variable
that was applied in Ceunen et al; (2016) was adopted as a starting point to
construct the variables attitude (traffic), subjective norm (traffic), perceived
behavioral control (traffic), behavioral intention (traffic) and behavior (traffic). For
the variables concerning traffic safety at railway crossings, all items of the
corresponding questions were included as a base for the construction of the
variables attitude (railway crossings), past behavior (railway crossings),
behavioral intention (railway crossings) and self efficacy (railway crossings).

For the process evaluation, different elements of cognitive and emotional program
impact were combined into the two overarching constructs cognitive program
impact and emotional program impact. In the first post-test dataset, the
evaluation scores on credibility, usefulness, interestingness, importance,
informativeness on the one hand (cognitive elements) and shockingness,
perturbation, frighteningness on the other hand (emotional elements) are first
reversed by using the SPSS function Transform -> Data -> Recode into Different
Variables. Then the mean scores on the variables cognitive and emotional program
impact are computed with the SPSS function Transform -> Compute Variable and
the formula MEAN ().

Reliability tests are performed on these combined items and - if necessary — some
items are left out to improve the reliability scores. The Cronbach’s alpha was
calculated for all combined items with the SPSS-function Analyze -> Scale ->
Reliability Analysis with the model “Alpha”. It is then checked which alphas are
not greater than 0.65. For the variables for which this is the case, it is investigated
whether and which items can be omitted so that there is an increase. An item was
only deleted for the variables perceived behavioral control (traffic) and behavior
(traffic). This is based on the reliability analysis for the pre-test. For the other
datasets, the composition of the variables has been retained. Table 6 shows the
Cronbach’s alphas for each of the phases (pre-test, 15t post-test and 2" post-test)
in the pre-test dataset and the two merged datasets. For the variable subjective
norm (traffic), the Cronbach's alpha remains below 0.65 in some cases, as is the
case for the variable behavioral intention (traffic).
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Table 6 - Cronbach’s alphas for all phases (pre-test, 1st post-test and 2"d post-test) in the pre-test and the two merged datasets

Impact

Variable Cronbach’s Cronbach’s Cronbach’s Cronbach’s Cronbach’s Cronbach’s

alpha alpha alpha alpha alpha alpha
pre-test prepost 1 prepost 1 prepost 2 prepost 2 prepost 2
(n=763) pre (n=197) postl (n=197) | pre (n=77) postl (n=77) post2 (n=197)

Attitude (traffic) 0.80 0.78 0.80 0.78 0.83 0.86

Subjective norm 0.66 0.61 0.66 0.68 0.66 0.60

(traffic)

Perceived Behavioral 0.65 0.65 0.68 0.66 0.68 0.69

Control (traffic)

Behavioral Intention 0.67 0.64 0.71 0.68 0.73 0.71

(traffic)

Behavior (traffic) 0.77 0.75 0.87 0.79 0.87 0.83

Attitude (railway 0.87 0.87 0.89 0.90 0.85 0.84

crossings)

Behavioral Intention 0.92 0.91 0.92 0.90 0.93 0.86

(railway crossings)

Past Behavior (railway 0.91 0.90 0.90 0.89 0.85 0.76

crossings)

Self Efficacy (railway 0.87 0.85 0.89 0.81 0.91 0.91

crossings)

Cognitive Program N/A N/A 0.83 N/A N/A N/A

Impact

Emotional Program N/A N/A 0.84 N/A N/A N/A




A test-retest reliability analysis was also performed to measure the stability of the
test over time. This happened on both merged datasets. In each case, the Pearson
correlation coefficient was calculated between 2 measurements using the SPSS
function Analyze -> Correlate -> Bivariate with the options “Pearson”, “two-
tailed”, and “exclude cases pairwise”. Table 7 shows the Pearson correlation
coefficients between pre- and 15t post-test in the 1% post-test dataset and between
pre-test and 1%t post-test, between pre-test and 2" post-test and between 1
post-test and 2" post-test in the 2" post-test dataset. Significant differences
(p<0.05) are indicated with an asterix (*). As mentioned in paragraph 3.4.2,
something went wrong when formulating the answer options for the question
about past behavior at railway crossings in the 1t post-test, leading to a very low
Pearson correlation effect for every pair of measurements that includes the 1
post-test.

Table 7 - Pearson correlation coefficient between the different measurements in the 1st
and 2"9 post-test dataset

Variable Prepostl Prepost2
(n=197) (n=77)
Pearson Pearson Pearson Pearson
correlation | correlation correlation correlation
pre- vs. pre- vs. pre- vs. post-test 1 vs.
post-test 1 | post-test 1 post-test 2 post-test 2
Attitude (traffic) 0.74 0.77 0.72 0.77
Subjective norm 0.62 0.55 0.51 0.59
(traffic)
Perceived Behavioral 0.74 0.71 0.58 0.68
Control (traffic)
Behavioral Intention 0.62 0.57 0.55 0.63
(traffic)
Behavior (traffic) 0.57 0.47 0.57 0.54
Attitude (railway 0.36 0.57 0.60 0.63
crossings)
Behavioral Intention 0.35 0.58 0.45 0.68
(railway crossings)
Past Behavior 0.12* 0.05* 0.35 0.02*
(railway crossings)
Self Efficacy (railway 0.42 0.42 0.47 0.49
crossings)

In the first post-test dataset (n=197), there is a significant difference between the
control group and the experimental group on gender, with Pearson Chi-Square
(2,n=197)=7.65, p=0.02. There is a significantly higher proportion of female
students in the control group than in the experimental group. There is also a
significant difference between the control group and the experimental group on
grade, with Pearson Chi-Square (1,n=197)=7.10, p=0.01. There is a significantly
higher proportion of 3™ graders in the experimental group than in the control
group. Finally, there is a significant difference between the control group and the



experimental group in terms of study domain, with Pearson Chi-Square
(2,n=197)=188.08, p<0.01. There is a significantly lower proportion of
throughflow finality students and a significantly higher proportion of double finality
and labor market finality students in the control group than in the experimental
group.

When looking at the differences between the control group and the experimental
group in the second post-test dataset (n=77), a significant difference is found on
gender, with Pearson Chi-Square (1,n=77)=4.56, p=0.03. There is a significantly
higher proportion of female students in the control group than in the experimental
group. There is also a significant difference between the control group and the
experimental group on grade, with Pearson Chi-Square (1,n=77)=4.72, p=0.03.
There is a significantly higher proportion of 3™ graders in the experimental group
than in the control group. Finally, there is a significant difference between the
control group and the experimental group in terms of study domain, with Pearson
Chi-Square (2,n=197)=68.40, p<0.01. There is a significantly lower proportion of
throughflow finality students and a significantly higher proportion of double finality
and labor market finality students in the control group than in the experimental

group.

Next, the same analysis is done for the three groups that are obtained when the
experimental group is split into a live testimonial experimental group and a video
testimonial experimental group. In the first post-test dataset (n=197), there is a
marginally significant difference between the control group, the live testimonial
experimental group and the video testimonial experimental group on gender, with
Pearson Chi-Square (4,n=197)=8.83, p=0.07. There is a significantly higher
proportion of female students in the control group than in the live testimonial
experimental group. There is also a significant difference between the control
group and the experimental group on grade, with Pearson Chi-Square
(2,n=197)=28.82, p<0.01. There is a significantly higher proportion of 3™ graders
in the live testimonial experimental group than in the video testimonial
experimental group and the control group. Finally, there is a significant difference
between the control group and the experimental group in terms of study domain,
with Pearson Chi-Square (4,n=197)=188.09, p<0.01. There is a significantly
lower proportion of throughflow finality students and a significantly higher
proportion of double finality and labor market finality students in the control group
than in the live and video testimonial experimental groups.

When looking at the differences between the control group, the live testimonial
experimental group and the video testimonial experimental group in the second
post-test dataset (n=77), a significant difference is found on gender, with Pearson
Chi-Square (2,n=77)=7.92, p=0.02. There is a significantly higher proportion of
female students in the control group than in the live testimonial experimental
group. There is also a significant difference between the control group, the live
testimonial experimental group and the video testimonial experimental group on
grade, with Pearson Chi-Square (2,n=77)=20.18, p<0.01. There is a significantly
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higher proportion of 3™ graders in the live testimonial experimental group than in
the video testimonial experimental group and the control group. Finally, there is
a significant difference between the control group, the live testimonial
experimental group and the video testimonial experimental group in terms of
study domain, with Pearson Chi-Square (4,n=77)=68.40, p<0.01. There is a
significantly lower proportion of throughflow finality students and a significantly
higher proportion of double finality and labor market finality students in the control
group than in the experimental group.

3.6.2 Data analysis for the measurement of (socio-cognitive determinants
of) behavior in traffic in general and at railway crossings in particular

The analyses for the measurement of behavior are performed on the main/pre-
test dataset of 763 cases. To describe the study sample in this dataset using a
series of socio-demographic variables and variables related to traffic behavior and
exposure to railway crossings, the SPSS function Frequencies is used (Analyze ->
Descriptive Statistics -> Frequencies). Under “Charts” both Bar charts and Pie
charts are selected (two different output files).

Significant differences (p<0.05) on categorical variables between subgroups
(gender, grade and study domain) are calculated with the SPSS function Crosstabs
(Analyze -> Descriptive Statistics -> Crosstabs). The categorical variables are
added in the columns and the variables that determine the subgroups are added
to the rows. Under “Statistics”, Chi-quare is selected and under “Cells”, Row
Percentages are selected. To make pairwise comparisons between the three study
domains, a univariate ANOVA is performed using the SPSS-function Analyse ->
General Linear Model -> Univariate with the categorical variables as Dependent
Variable and study domain as Fixed Factor. The Estimated Marginal Means are
displayed for study domain and are compared with Confidence interval
adjustment: Bonferroni.

Means of continuous variables and significant differences (p<0.05) on these
means between subgroups (gender, grade and exposure) are calculated with the
SPSS function Independent Samples t-test (Analyze -> Compare Means and
Proportions -> Independent-Samples T test). The continuous variables are added
as Test Variables and the variables that determine the subgroups are added as
Grouping Variables. In the SPSS output, the Levene Test for Equality of Variances
is first interpreted: if this appears significant, equal variances are assumed, and
the corresponding two-sided p is taken into account. Otherwise, the other two-
sided p is used. The most important examples of continuous variables in this study
are the mean scores on the constructed socio-cognitive variables that determine
behavior in traffic and at railway crossings.
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Significant differences (p<0.05) between study domains were calculated with a
Multivariate Analysis of Variance (MANOVA, SPSS-function Analyse -> General
Linear Model -> Multivariate) for the socio-cognitive variables that determine
traffic safety in general, with the socio-cognitive variables as Dependent Variables
and study domain as Fixed Factor. The Estimated Marginal Means are displayed
for study domain and are compared with Confidence interval adjustment:
Bonferroni.

For the variables with a significant effect in the MANOVA, pairwise comparisons
are made between the three study domains, by performing a univariate ANOVA
using the SPSS-function Analyse -> General Linear Model -> Univariate with the
socio-cognitive variable at hand as Dependent Variable and study domain as Fixed
Factor. The Estimated Marginal Means are displayed for study domain and are
compared with Confidence interval adjustment: Bonferroni.

For the socio-cognitive variables that determine behavior at railway crossings, a
comparable analysis is performed. However, univariate Analysis of Variance
(ANOVA) is used for each of these variables instead of MANOVA for all the variables
together, as is done for the variables that determine traffic safety in general.
Whereas the variables with regard to traffic safety in general were treated as a
group because they originate from a previous study (Cuenen et al., 2016), the
variables with regard to railway crossings were constructed for this study.
Therefore, assumptions on interconnection between them were not made.

Finally, it is important to mention that all analyses regarding study domain are
done without the (three) cases in which respondents indicated that they don’t
know in what study domain they are. This is done by applying the SPSS-function
Data-> Select Cases.

3.6.3 Data analysis for the search for factors that predict attitudes and
behavior at railway crossings

The analyses for the measurement of behavior are performed on the main/pre-
test dataset of 763 cases. To get insight into the socio-demographical and socio-
cognitive variables that are able to predict attitudes, past behavior and behavioral
intention at railway crossings, a Linear Regression is performed, using the SPSS
function Linear Regression (Analyze -> Regression -> Linear). The analysis is done
for 3 dependent variables: attitude (railway crossings), past behavior (railway
crossings)and behavioral intention (railway crossings). These variables are
entered under “Dependent”. The independent variables that are used for the
analysis are socio-demographical and socio-cognitive variable. The socio-
demographical variables are the same for the 3 dependent variables: gender,
grade and study domain. They are entered under Block 1 of “Independent(s)”.
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The socio-cognitive variables that are included in the analysis (and also entered
under Block 1 of “Independent(s)”), differ for each of the dependent variables.
They are determined on the basis of a correlation analysis (Analyze -> Correlate
-> Bivariate): only one of two correlated independent variables (Pearson
correlation>0.65 and p<0.01) is included. It appears that behavioral intention
(traffic) is correlated with behavior (traffic) (Pearson correlation = 0.68 and
p<0.01). It is decided that behavioral intention (traffic) will be excluded from the
linear regression analysis.

For the dependent variable “attitude (railway crossings)”, the following
independent variables are entered into the linear regression analysis: subjective
norm (traffic), perceived behavioral control (traffic), behavior (traffic), behavioral
intention (railway crossings), past behavior (railway crossings) and self efficacy
(railway crossings).

For the dependent variable “past behavior (railway crossings)”, the independent
variables that are considered in the analysis are: attitude (traffic), subjective norm
(traffic), perceived behavioral control (traffic), behavior (traffic), attitude (railway
crossings), behavioral intention (railway crossings) and self efficacy (railway
crossings).

For the third and final dependent variable, “behavioral intention (railway
crossings)”, the following independent variables are included in the linear
regression analysis: attitude (traffic), subjective norm (traffic), perceived
behavioral control (traffic), behavior (traffic), attitude (railway crossings), past
behavior (railway crossings) and self efficacy (railway crossings).

This complies with the rule of thumb that states that the maximum number of
independent variables that are included in the analysis, is one per 10-15
respondents. With a sample of 763 respondents, up to 51 independent variables
could be added.

The method “Enter” is chosen. All independent variables are included in the
regression equation. The adjusted R2 and the significance of the ANOVA are
examined. If the significance of the ANOVA is below 0.05, the p-value of the
coefficients are examined. The variables with a p-value higher than 0.05 are
removed and the adjusted R2 is examined again for a possible increase. As long
as the adjusted R2 can be increased, these steps are repeated.

3.6.4 Data analysis for the process evaluation

The analyses for the process evaluation were performed on the first post-test
dataset and specifically for the experimental group (Data -> Select Cases was
used). This sub-dataset consisted of 167 cases. To describe the study sample in
this sub-dataset on a series of variables that explain (elements of) cognitive and
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emotional impact, preference and some qualitative elements, such as duration,
clarity and performance of the speaker, the SPSS function Frequencies is used
(Analyze -> Descriptive Statistics -> Frequencies). Under “Charts” both Bar charts
and Pie charts are selected (two different output files).

Significant differences (p<0.05) on these mainly categorical variables between
subgroups (live vs. video testimonial experimental group and birth year) are
calculated with the SPSS function Crosstabs (Analyze -> Descriptive Statistics ->
Crosstabs). The categorical variables are added in the columns and the variables
that determine the subgroups are added to the rows. Under “Statistics”, Chi-quare
is selected and under “Cells”, Row Percentages are selected.

To compare the means of the continuous variables cognitive and emotional
program impact with one another, the SPSS function Paired-Samples t-test
(Analyze -> Compare Means and Proportions -> Paired-Samples T test) with
cognitive program impact as Variable 1 and emotional program impact as Variable
2.

Significant differences (p<0.05) on these means of the variables cognitive and
emotional program impact between subgroups (live vs. video testimonial
experimental group, gender, grade) are calculated with the SPSS function
Independent Samples t-test (Analyze -> Compare Means and Proportions ->
Independent-Samples T test). The continuous variables are added as Test
Variables and the variables that determine the subgroups are added as Grouping
Variables. In the SPSS output, the Levene Test for Equality of Variances is first
interpreted: if this appears significant, equal variances are assumed, and the
corresponding two-sided p is taken into account. Otherwise, the other two-sided
p is used. To examine the possible significant differences between subgroups
(gender and grade) for the different formats (live and video testimonial), the SPSS
function Data-> Split File is used with to organise the output by format.

Differences between study domains study domains cannot be examined for the
variables under study of in the process evaluation, as all students in the
experimental group(s) are in the throughflow finality.

3.6.5 Data analysis for the effect evaluation

In a first step of the analysis, a repeated measures MANOVA was performed on
the socio-cognitive variables that determine traffic safety in general. In SPSS,
Analyze -> General Linear Model -> Repeated Measures was selected.
“Measurement” was chosen as the Within-Subject Factor Name and the number
of levels was set at 2 for the pre-test-post-test analysis for the first post test and
at 3 for pre-test-post-test analysis for the second post test (for results see
paragraph 4.3 and 4.4 respectively). All variable names were jointly inserted as
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Measure Names. The different Measurement (1, 2, 3) of the Within-Subject
Variables were then defined/added and the variable group (with values live
testimonial experimental group, video testimonial experimental group and control
group) was added as the Between-Subjects Factor. Furthermore, under Plots, the
Measurement was selected for the horizontal axis and the variable group was
selected for Seperate Lines. Finally, The Estimated Marginal Means were displayed
for Measurement and were compared with Confidence interval adjustment:
Bonferroni.

When a significant (p<0.05) or marginally significant (0.05<p<0.10) multivariate
within subject interaction effect was found, the univariate within subject
interaction effect was examined. For the variables for which a significant (p<0.05)
or marginally significant (0.05<p<0.10) univariate within subject interaction
effect was found, extra analyses were performed to better understand the
(marginal) effects that arose.

The possible significant difference between pre-test and post-test for each of these
groups was examined by repeating the repeated measure MANOVA on the
different groups separately (the Data -> Split File function in SPSS was used to
separate the group results and the variable “"Group” was removed as a Between-
Subjects Factor). Only the variables for which there is 1) no significant difference
(p>0.05) for the control group between the two or three measurements and 2) a
significant (p<0.05) or marginally significant (0.05<p<0.10) effect on either the
live testimonial experimental group or the video testimonial experimental group
or both, are considered to represent a noteworthy effect on the examined
variables.

For the variables for which no significant or marginally significant (p>0.10)
univariate within subject interaction effect was found, the main effects for group
(live and video testimonial experimental group and control group) and
measurement (pre-test and post-test) are examined. For the main effect for
group, the multivariate between-subject effect for group is examined for
significance (p<0.05). For the main effect for measurement, the univariate within
subject effect is examined for significance (p<0.05).

As opposed to the variables with regard to traffic safety in general, the variables
that determine behavior at railway crossings were analysed separately, using a
repeated measures univariate ANOVA. Whereas the variables with regard to traffic
safety in general were treated as a group because they originate from a previous
study (Cuenen et al., 2016), the variables with regard to railway crossings were
constructed for this study. Therefore, assumptions on interconnection between
them were not made. The settings in SPSS are similar to those of the MANOVA.
However, there is no need to fill in the Measure Name.

As for the MANOVA, when a significant univariate within subject interaction effect
was found in the repeated measures univariate ANOVA, extra analyses were
performed to better understand the (marginal) effects that arose.
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The possible significant difference between pre-test and post-test for each of these
groups was once again examined by repeating the repeated measure univariate
ANOVA on the different groups separately (the Split File function in SPSS was used
to separate the group results). Only the variables for which there is 1) no
significant difference (p>0.05) for the control group between the different
measurements and 2) a significant (p<0.05) or marginally significant
(0.05<p<0.10) on either the live testimonial experimental group or the video
testimonial experimental group, are considered to represent an noteworthy effect
on the examined variables.

For the variables for which no significant or marginally significant (p>0.10) within
subject interaction effect was found, the main effects for group (live and video
testimonial experimental group and control group) and measurement (pre-test
and post-test) are examined. For the main effect for group, the between-subject
effect is examined for significance (p<0.05). For the main effect for measurement,
the within subject effect is examined for significance (p<0.05).
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4 Results

In this chapter, the results of three main analyses will be presented: the
measurement of attitudes and behavior at railway crossings among Flemish youth,
the evaluation of the live and video testimonials and the effect evaluation that
looks into the effect of the live and video testimonials on the socio-cognitive and
behavioral variables under examination.

4.1 Measuring (socio-cognitive determinants of) behavior in traffic in
general and at railway crossings in particular among Flemish youth

This cross-sectional study was performed on a dataset of 763 cases (completed
or nearly completed surveys). In the following paragraphs, the study sample is
first described with regard to socio-demographics, mode choice and exposure to
railway crossings. Subsequently, attitudes and behavior with regard to traffic
safety in general are examined and the results are presented on a sample level
and on a subgroup level (gender, grade and study domain) to search for significant
differences between these subgroups. Finally, the main findings regarding
attitudes and behavior at railway crossings are presented on a sample level as
well as on a subgroup level.

4.1.1 Description of the study sample with regard to socio-demographics

Almost two thirds of the respondents are female (64%). Most respondents were
born in 2007 (31.1%), almost 95% was born between 2006 and 2009, as shown
in figure 5 below.

=
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2004 2005 2006 2007 2008 2009 2010

Year of Birth

Figure 5 - Distribution of study sample on birth year
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Almost a third of the respondents is in the 5th year (32.6%). The fourth and sixth
year are also well represented, with respectively 22.1 and 25.0%. Almost 60% of
the respondents are in 3™ grade (7" year included).

Two thirds of the respondents are in the throughflow finality study domain
(“doorstroomfinaliteit”). Only 9% is in the labor market finality study domain
(“arbeidsmarktfinaliteit”).

4.1.2 Description of the study sample with regard to mode choice to travel to
school

Almost 78% of the study sample travel to school sustainably (by foot, bike or
public transport) with a balance between bus (29.9%) and bicycle (31.6%). While
20.3% of respondents indicated they have a drivers license for a car (both
temporary and permanent), only 2% travels to school by car as a driver.

There is a significant difference between male and female students when it comes
to the main transport mode from home tot school (p<0.01 on a Pearson Chi-
Square test). For example, 39.2% of male students travel to school by bike,
compared to only 24.8% of female students. Also, significantly more male
students (14.1%) go to school by train than female students (8.0%). On the other
hand, 20.8% of male students travels to school by bus, compared to 38.1% of
female students.

There is also a significant difference between 2" graders and 3™ graders when it
comes to their main transport mode from home tot school (p<0.01 on Pearson
Chi-Square). More specifically, 25.6% of 2" graders goes to school by bike,
compared to 32.8% of 3™ graders. Second graders travel to school significantly
more by bus (38.5%) than 3™ graders (26.9%).

Finally, there is a significant difference between the study domains when it comes
to the main transport mode from home tot school (p<0.01 on Pearson Chi-
Square). For example, 37.6% of throughflow finality students go to school by bike,
compared to only 17.4% of students in double finality (“dubbele finaliteit”) and
only 5.9% of labor market finality. A significant difference is found between each
of the study domains. Significantly fewer students in the throughflow finality study
domain (24.2%) travel school by bus, than their double finality (46.2%) and labor
market finality counterparts (47.1%).

The difference in main mode choice to travel to school between study domains
most likely reflect differences between the two schools when it comes to mobility
options (e.g., location of the school, presence of a train station, availability of bus
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connections, ...). This will further be discussed in chapter 6 Limitations and future
research.

4.1.3 Main findings regarding traffic safety in general

Five percent of respondents indicates that they ever received a traffic fine. One
respondent states that he or she has ever received a fine for crossing a railway
track where this was not allowed, and one respondent received a fine for breaking
the rules at a railway crossing. The most common traffic fines are for cycling
without the hands on the handlebar (31.6%), for speeding (13.2%) and for red
light negation (10.5%).

A significant difference can be found between male and female students when it
comes to having ever received a traffic fine (p < 0.01 on Pearson Chi-Square).
Among male students, 9.1% has ever received a fine, compared to only 2.5% of
female students. There is also a significant difference between study domains
when it comes to having ever received a traffic fine (p < 0.01 on Pearson Chi-
Square).

About a third of respondents (32.6%) has ever been involved in an accident. 5
respondents indicate that they have ever been involved in an accident at a railway
crossing, but it is not clear whether a train was involved and which mode they
were using at the time of the accident. There are no significant differences
between male and female students, 2" and 3™ graders and study domains, when
it comes to involvement in accidents.

Table 6 shows an overview of the total sample means on the socio-cognitive and
behavioral variables with regard to traffic safety in general and the means for each
subgroup, with the significant differences between the subgroups shown with an
asterix. The means are calculated as the average score on a number of items,
which were asked using a five-point scale, where the maximum score is 5 and this
maximum score always represents the safest score. This was described in more
detail in paragraph 3.4 and 3.7.

The variables Behavioral Intention (traffic) and Behavior (traffic) have the highest
means: 4.20 and 3.77 respectively. The variables attitude (traffic) and subjective
norm (traffic) have a lower mean with respectively 3.56 and 3.38. Respondents
score the lowest on the variable perceived behavioral control, with a mean of only
3.08.

Different subgroups have significantly different means for these variables. Female
students, for example, score significantly higher (and thus safer) on the variable
attitude (traffic), which represents attitude towards traffic safety in general (t
(741) =-3.33, p < 0.01). They also score significantly higher on perceived
behavioral control towards traffic safety in general (t(741) = -2.41, p = 0.02).
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However, there is no significant difference between male and female students
when it comes to subjective norm (traffic) (t(741) = 1.13, p = 0.26), behavioral
intention (traffic)(t(741) = 0.06, p = 0.95) and behavior (traffic) (t(741) = 0.54,
p = 0.59).

There is a significant difference between 2" and 3™ graders on the variables
attitude (traffic) (t(761) = -5.69, p < 0.01), perceived behavioral control (traffic)
(t(761) = -2.08, p = 0.04), behavioral intention (traffic) (t(761) = -3.90, p <
0.01) and behavior (traffic) (t(761) = -4.40, p < 0.01). Third graders score
significantly higher on all of these variables. This 3™ graders can be regarded as
safer in attitude, intention and behavior in traffic in general. However, there is no
significant difference between 2" and 3™ graders when it comes to subjective
norm (traffic) (t(609.35) = -0.13, p = 0.90).

There is also a significant difference between study domains when it comes to
perceived behavioral control (traffic), behavioral intention (traffic) and behavior
(traffic). A significant multivariate effect was found: F(10,1508) = 3.28, p < 0.01.
A significant univariate between-subjects effect was found for perceived
behavioral control (traffic) (F(2,757) = 4.56, p = 0.01), for behavioral intention
(traffic): F(2,757) = 3.14, p = 0.04 and for behavior (traffic) (F(2,757) = 4.99, p
= 0.01).

A univariate ANOVA for each of these variables with a pairwise comparison
between the study domains, shows that throughflow finality students score
significantly lower (and thus less safe) on perceived behavioral control (p = 0.03)
than their labor market finality counterparts. On the other hand, it shows that
throughflow finality students score significantly higher (and thus safer) on
behavioral intention (traffic) and behavior (traffic) than labor market finality
students, with respectively p = 0.04 and p = 0.01.
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Table 8 - Overview of means on socio-cognitive and behavioral variables with regard to traffic safety in general (*sign. diff. between
subgroups p<0.05)

Variable Total Male Female 2nd 3rd Through- = Double Labor
mean (n=488) grade grade flow finality market
(n=763) | (n=255) (n=309) (n=454) | finality (n=184) finality
(n=508) (n=68)
Attitude (traffic) 3.56 3.50% 3.61% 3.46%* 3.64%* 3.57 3.57 3.55
Subjective Norm (traffic) 3.38 3.41 3.37 3.38 3.39 3.39 3.38 3.40
Perceived Behavioral Control (traffic) 3.08 3.01%* 3.12%* 3.02* 3.11%* 3.03* 3.17%* 3.18%*
Behavioral Intention (traffic) 3.77 3.77 3.77 3.66%* 3.84%* 3.80% 3.75% 3.60%
Behavior (traffic) 4.20 4.19 4.22 4.08%  4.29% 4.25% 4.17%  4.00%




4.1.4 Description of the study sample with regard to exposure to railway
crossings

Just over half of the respondents (51%) are exposed to a railway crossing when
going to school. More than one third (35.1%) crosses a railway crossing every day
or nearly every day. Almost two thirds of respondents are exposed to a railway
crossing on other occasions than travelling to school (63.3%). Almost four out of
ten times this exposure happens either by foot, by bike of by moped, both for
school (39.5%) as for non-school travel (37.1%). Almost eight out of ten
respondents (78%) are exposed to a railway crossing in either school or non-
school travel or both. Nearly half of the respondents (48.6%) lives within one
kilometre of a railway crossing.

Male students are significantly more exposed to railway crossings when traveling
to school than female students (p < 0.01 on Pearson Chi-Square). Well over 50%
of female students (53.5%) do never cross a railway crossing, compared to only
42.7% of male students. Forty percent of male students do it every day or nearly
every day, compared to only 31.1% of female students.

There is also a significant difference between 2" graders and 3™ graders when it
comes to the exposure to railway crossings from home tot school (p < 0.01 on
Pearson Chi-Square). For instance, 57.9% of 2" graders never crosses a railway
crossing when travelling to school, compared to only 43% of 3™ graders.
Furthermore, 28.2 % of 2" graders is exposed to a railway crossing every day or
nearly every day, compared to 39.9% of 3™ graders.

Finally, there is also a significant difference between study domains when it comes
to the exposure to railway crossings from home tot school (p < 0.01 on Pearson
Chi-Square). After all, 41.3% of students in the throughflow finality study domain
never crosses a railway crossing, compared to 61.4% of students in double finality
and 73.5% of students in labor market finality (there is no significant difference
between students in these latter two study domains). Moreover, 41.7% of
throughflow finality students cross a railway crossing every day or nearly every
day, compared to only 23.9% of double finality and 14.7% of labor market
students (no significant difference between the latter two).

The difference in exposure to railway crossings when travelling to school between
study domains might reflect differences between the two schools in terms of the
location of important neighbouring residential zones in relation to the railway
crossing(s) in the area. This will further be discussed in chapter 6 Limitations and
future research.

There is a significant difference between 2" graders and 3™ graders when it comes
to the exposure to railway crossings on other routes than from home tot school (p



= 0.01 on Pearson Chi-Square). Indeed, 43.4% of 2"¢ graders never crosses a
railway crossing in those circumstances, compared to 32.2% of 3™ graders.

There is also a significant difference between study domains when it comes to the
exposure to railway crossings on other routes than from home tot school (p =
0.02 on Pearson Chi-Square). More than half of the students in labor market
finality (54.4%) never crosses a railway crossing, compared to only 35.9% of
double finality and 34.3% of throughflow finality students (no significant difference
between the latter two). Significantly more students in the throughflow finality
study domain crosses a railway crossing on other routes than from home to school
every day or nearly every day (9.6%) than labor market finality students (2.9%).

The difference in exposure to railway crossings on other occasions than travelling
to school between study domains might reflect differences between schools in
terms of railway track density in the area. This will further be discussed in chapter
6 Limitations and future research.

4.1.5 Main findings regarding (socio-cognitive determinants of) behavior at
railway crossings on a sample level

4.1.5.1 Socio-cognitive variables that determine behavior at railway crossings

Four variables were included in the analyses that deal particularly with behavior
at railway crossings: attitude (railway crossings), behavioral intention (railway
crossings), past behavior (railway crossings) and self efficacy (railway crossings).
Table 7 shows an overview of the total sample means on these socio-cognitive
and behavioral variables with regard to traffic safety at railway crossings and the
means for each subgroup, with the significant differences between the subgroups
shown with an asterix. As is the case with the variables on traffic safety in general,
the means in the overview table are calculated as the average score on a number
of items, which were asked using a five-point scale, where the maximum score is
5 and this maximum score always represents the safest score. This was described
in more detail in paragraph 3.4 and 3.7.

The variables attitude (railway crossings) and past behavior (railway crossings)
have the highest means: 4.05 and 4.50 respectively. The variables behavioral
intention (railway crossings) and self efficacy (railway crossings) have a lower
mean with respectively 3.86 and 3.59.

Female students score significantly higher (and thus safer) on attitude (railway
crossings), which represents attitude towards traffic safety at railway crossings
(t(732) =-3.34, p < 0.01). They also score significantly better on past behavior
(railway crossings), meaning that they less frequently displayed unsafe behavior
at railway crossings in the past 6 months (t(721) = -2.49, p = 0.01). Male
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students, however, score significantly higher on self efficacy (railway crossings)
than female students (t(718) = 2.02, p = 0.04).

However, there is no significant difference between male and female students
when it comes to behavioral intention (railway crossings) (t(726) = -0.93, p =
0.35).

There is a significant difference between 2" and 3™ graders on the variables
attitude (railway crossings) (t(625.43) = -3.23, p < 0.01), behavioral intention
(railway crossings) (t(745) = -2.37, p = 0.02) and self efficacy (railway crossings)
(t(737) = -2.82, p = 0.01). Third graders score significantly higher on all of these
variables. However, there is no significant difference between 2" and 3™ graders
when it comes to past behavior (railway crossings) (t(740) = -0.33, p = 0.74).

A univariate ANOVA for each of these variables shows that there are no significant
differences between the study domains on attitude (railway crossings) (F(2,748)
= 1.49, p = 0.23)), behavioral intention (railway crossings)(F(2,741) = 0.92, p =
0.40)), past behavior (railway crossings)(F(2,736) = 1.79, p = 0.17) and self
efficacy (railway crossings)(F(2,733) = 0.08, p = 0.92).

56



Table 9 - Overview of means on socio-cognitive and behavioral variables with regard to traffic safety at railway crossings (*sign

between subgroups)

. diff.

Variable

Attitude (railway crossings)

Behavioral Intention (railway
crossings)

Past Behavior (railway crossings)

Self Efficacy (railway crossings)

Total
mean
(n=763)

4.05

3.86

4.50

3.59

Male

(n=255)

3.95%

3.82

4.41%

3.67%

Female
(n=488)

4.14*

3.89

4.57%

3.55%

2nd
grade
(n=309)

3.95%

3.75%

4.49

3.50%*

3rd
grade
(n=454)

4.13*

3.94%*

4.51

3.66%*

Through-
flow
finality
(n=508)

4.04

3.86

4.47

3.60

Double
finality
(n=184)

4.14

3.92

4.60

3.58

Labor
market
finality
(n=68)

4.01

3.71

4.45

3.58




There is a significant difference between students who are exposed to railway
crossings (on trips from home to school and/or other occasions) and students who
are not on the variable past behavior (railway crossings) (t(740) = 3.37, p< 0.01).
People who are exposed to railway crossings score significantly lower (and thus
less safe) on this variable, which means that the have more frequently behaved
unsafe at railway crossings in the past. However, there is no significant difference
between these subgroups when it comes to attitude (railway crossings) (t(245.85)
= 0.66, p = 0.51), behavioral intention (railway crossings) (t(256.30) = 0.84, p
= 0.40) and self efficacy (railway crossings) (t(248.13) = -0.19, p = 0.85).

There is a significant difference between students who live near a railway crossings
(within 1 km) and students who do not on the variables attitude (railway
crossings) (t(701.75) = -2.82, p = 0.01) and past behavior (railway crossings)
(t(687.57) = -2.42, p = 0.02). People who live near railway crossings score
significantly lower on both variables, which means that they have a less safe
attitude towards unsafe behavior at railway crossing and that hey have more
frequently behaved unsafe at railway crossings in the past. However, there is no
significant difference between these subgroups when it comes to behavioral
intention (railway crossings) (t(679.64) = -0.60, p = 0.55) and self efficacy
(railway crossings) (t(637.20) = -0.04, p = 0.97).

4.1.5.2 Different types of behaviors at railway crossings

It is also interesting to take a closer look at the seven different forms of risky
behavior at railway crossings, which were separately presented to the students in
the surveys and later aggregated into the constructs attitude (railway crossings),
behavioral intention (railway crossings) and past behavior (railway crossings).

These 7 forms of behavior at railway crossings can be divided into 3 behaviors
that are related to the timing and transitional phases of the signalling and 4
behaviors that are related to different types of distraction.

With regard to the timing of risky behavior, a person can cross a railway crossing
when the red lights are flashing and the barriers are completely closed, when the
red lights are flashing, but before the barriers are completely closed or when a
train has just passed, but before the barriers are completely open and the red
lights are still flashing. Respondents have different attitudes and intentions about
these behaviors and have performed them with different frequency in the past.

For example, 5.2% of respondents indicate that they don’t find it dangerous (not
at all and totally not) to cross a railway crossing when the red lights are flashing,
and the barriers are completely closed. Only 81.4% of respondents consider this
very dangerous. Furthermore, 2.6% of respondents indicate they have done it
more than once a week and 4.2% more than once a month in the past 6 months.




Finally, 12.2% of respondents indicate that it is (very) likely that they will be doing
it in the future.

For the behavior of crossing a railway crossing when the red lights are flashing,
but before the barriers are completely closed, 5.6% of respondents indicate that
they don’t find it dangerous. Only 45.2% of respondents consider this very
dangerous. Furthermore, 3.0% of respondents indicate they have done it more
than once a week and 5.7% more than once a month in the past 6 months. Finally,
13.1% of respondents indicate that it is (very) likely that they will be doing it in
the future.

With regard to crossing a railway crossing when a train has just passed, but before
the barriers are completely open and the red lights are still flashing, 8.7% of
respondents indicate that they don't find it dangerous. Only 37.1% of respondents
consider this very dangerous. Furthermore, 1.8% of respondents indicate they
have done it more than once a week and 5.2% more than once a month in the
past 6 months. Finally, 13.8% of respondents indicate that it is (very) likely that
they will be doing it in the future.

When looking at the behaviors that are related to different types of distraction, a
distinction can be made between crossing a railway crossing without carefully
looking at the signals, when visibility is limited due to bad weather conditions (e.qg.
fog or rain), when hearing is impaired (e.g. listening to music through
headphones) and while using a smartphone.

For example, 5.3% of respondents indicate that they don’t find it dangerous (not
at all and totally not) to cross a railway crossing without carefully looking at the
signals. Only 39.4% of respondents consider this very dangerous. Furthermore,
2.6% of respondents indicate they have done it more than once a week and 6.9%
more than once a month in the past 6 months. Finally, 13.5% of respondents
indicate that it is (very) likely that they will be doing it in the future.

With regard to crossing a railway crossing when visibility is limited due to bad
weather conditions, 10.6% of respondents indicate that they don’t find it
dangerous. Only 23.2% of respondents consider this very dangerous.
Furthermore, 3.0% of respondents indicate they have done it more than once a
week and 9.2% more than once a month in the past 6 months. Finally, 25.1% of
respondents indicate that it is (very) likely that they will be doing it in the future.

With regard to crossing a railway crossing when hearing is impaired, 14% of
respondents indicate that they don't find it dangerous. Only 21.6% of respondents
consider this very dangerous. Furthermore, 5.1% of respondents indicate they
have done it more than once a week and 12.9% more than once a month in the
past 6 months. Finally, 27.1% of respondents indicate that it is (very) likely that
they will be doing it in the future.
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Finally, for the behavior of crossing a railway crossing while using a smartphone,
5.6% of respondents indicate that they don’t find it dangerous. Only 43% of
respondents consider this very dangerous. Furthermore, 3.1% of respondents
indicate they have done it more than once a week and 7.3% more than once a
month in the past 6 months. Finally, 15.6% of respondents indicate that it is (very)
likely that they will be doing it in the future.

Female students score significantly higher (and thus safer) than male students on
attitude towards all mentioned risky behaviors (Pearson Chi-Square: p <0.05 for
all). There is also a significant difference between male and female students in
frequency of the mentioned risky behavior in the past six months (Pearson Chi-
Square: p <0.05 for all), except for crossing a railway crossing when hearing is
impaired (Pearson Chi-Square: p=0.47). With regard to when the red lights are
flashing and the barriers are completely closed, the significance is marginal
(Pearson Chi-Square: p=0.08). All significant differences indicate a safer behavior
of female students than their male counterparts. A significant difference in
behavioral intention is only found for crossing a railway crossing while using a
smartphone (Pearson Chi-Square: p=0.04).

Third grade students score significantly higher (and thus safer) than 2" grade
students on attitude towards crossing a railway crossing without carefully looking
at the signals (Pearson Chi-Square: p<0.01), when the red lights are flashing, but
before the barriers are completely closed (Pearson Chi-Square: p<0.01), when a
train has just passed, but before the barriers are completely open and the red
lights are still flashing (Pearson Chi-Square: p<0.01) and while using a
smartphone (Pearson Chi-Square: p=0.07), but not on attitude towards crossing
a railway crossing when the red lights are flashing and the barriers are completely
closed (Pearson Chi-Square: p=0.12),when visibility is limited due to bad weather
conditions (Pearson Chi-Square: p=0.18), when hearing is impaired (Pearson Chi-
Square: p=0.45). There is only a significant difference between 2" and 3™ grade
students in frequency of the mentioned risky behavior in the past six months for
crossing a railway crossing when hearing is impaired (Pearson Chi-Square:
p=0.04). Third graders did it more frequently than 2" graders. A significant
difference in behavioral intention is found for crossing a railway crossing when the
red lights are flashing and the barriers are completely closed (Pearson Chi-Square:
p<0.01), when the red lights are flashing, but before the barriers are completely
closed (Pearson Chi-Square: p=0.02) and when a train has just passed, but before
the barriers are completely open and the red lights are still flashing (Pearson Chi-
Square: p<0.01). Third grade students score significantly higher (and thus safer)
than 2" grade students on the intention towards these risky behaviors. Also, a
marginally significant difference is found for the intention towards crossing a
railway crossing without carefully looking at the signals (Pearson Chi-Square:
p=0.10). Here, also, 3™ graders are safer.

There is a significant difference between students of different study domain on
attitude towards attitude towards crossing a railway crossing when the red lights
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are flashing and the barriers are completely closed(Pearson Chi-Square: p=0.03),
when a train has just passed, but before the barriers are completely open and the
red lights are still flashing(Pearson Chi-Square: p=0.04), without carefully looking
at the signals(Pearson Chi-Square: p=0.04), when hearing is impaired (Pearson
Chi-Square: p<0.01), while using a smartphone (Pearson Chi-Square: p<0.01).
Throughflow finality students have a significantly safer attitude than labor market
finality students towards crossing a railway crossing when the red lights are
flashing, and the barriers are completely closed and while using a smartphone.
Labor market finality students have a significantly safer attitude than throughflow
finality and double finality students towards crossing a railway crossing when a
train has just passed, but before the barriers are completely open and the red
lights are still flashing and than throughflow finality students towards crossing a
railway crossing when hearing is impaired. Double finality students have a
significantly safer attitude than throughflow finality students towards crossing a
railway crossing without carefully looking at the signals and when hearing is
impaired and than labor market finality students towards crossing a railway
crossing while using a smartphone.

There are no significant differences between students in different study domains
in frequency of the mentioned risky behaviors in the past six months (Pearson
Chi-Square: p >0.05 for all). A significant difference in behavioral intention is
found towards all mentioned risky behaviors (Pearson Chi-Square: p <0.05 for
all), except for crossing a railway crossing without carefully looking at the signals
(Pearson Chi-Square: p=0.17) and while using a smartphone (Pearson Chi-
Square: p=0.18). Labor market finality students have a significantly less safe
intention than throughflow and double finality students towards crossing a railway
crossing when the red lights are flashing and the barriers are completely closed
and when the red lights are flashing, but before the barriers are completely closed
and than double finality students towards crossing a railway crossing when a train
has just passed, but before the barriers are completely open and the red lights
are still flashing. On the other hand, labor market finality students have a
significantly safer intention than throughflow finality and double finality students
towards crossing a railway crossing when hearing is impaired. Double finality
students have a significantly safer intention than throughflow finality students
towards crossing a railway crossing when visibility is limited due to bad weather
conditions.

4.1.6 Main findings for the search for factors that predict attitudes and
behavior at railway crossings through linear regression

As explained in detail in paragraph 3.6.3, the “Enter” method is used initially, in
which all independent variables are included in the regression equation. For each
of the three selected dependent variables, the adjusted R2 is examined and an
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attempt is made to increase it by removing the independent variables for which
the p-value of the coefficients is higher than 0.05.

For the dependent variable attitude (railway crossings), the initial adjusted R2
equals 0.22. The ANOVA shows that the model is significant (F(9,732)=24.01,
p<0.01). The coefficients of the variables Gender (t(732)= 1.02, p=0.31), study
domain (t(732)= 0.74, p=0.46), and behavioral intention (railway crossings)
(t(732)= -0.98, p=0.33) are not significant. These independent variables are
therefor removed from the model. For the independent variable grade, the
coefficient is only marginally significant (t(732)= 1.93, p=0.05). It is therefor
decided to leave this variable in the model for now.

In a second run, the adjusted R2 remains stable at 0.22. The ANOVA shows that
the model is significant (F(6,735)=35.59, p<0.01). The coefficient of the variable
grade is, once again only marginally significant (t(735)= 1.74, p=0.08). It is
therefor decided to remove this variable from the model, to examine for a possible
increase of the adjusted R2.

After the removal of the variable grade from the model, the adjusted R2 remains
stable at 0.22. The ANOVA shows that the model is significant (F(5,736)=41.98,
p<0.01), meaning that the independent variable explains a significant portion of
the variation in attitude towards risky behavior at railway crossings. However, an
adjusted R2 of 0.22 can be considered as rather weak. The coefficients of the
independent variables are all significant. It is therefor decided that no more
variables will be remove from the model.

The independent variables that are retained in the model are attitude (traffic)
(B=0.14, t(736)=3.20, p<0.01), subjective norm (traffic)(B=0.08, t(736)=2.17,
p=0.03), perceived behavior control (traffic)(=-0.10, t(736)=-2.38, p=0.02),
behavior (traffic)(B=0.23, t(736)=5.72, p<0.01), past behavior (railway
crossings)(B=0.26, t(736)=7.66, p<0.01).

In other words, a safer attitude, subjective norm and behavior in traffic in general
and safer behavior in the past predict a safer attitude at railway crossing. On the
contrary, a safer perceived behavior control in traffic in general predicts a less
safe attitude at railway crossing.

For the dependent variable past behavior (railway crossings), the initial adjusted
R2 equals 0.31. The ANOVA shows that the model is significant (F(10,728)=34.42,
p<0.01). The coefficients of the variables Gender (t(728)= -0.94, p=0.35), study
domain (t(728)= 0.80, p=0.43), perceived behavioral control (traffic) (t(728)=
0.69, p=0.49), behavior (traffic)(t(728)= -0.11, p=0.91) and self efficacy (railway
crossings) (t(728)= -0.23, p=0.82) are not significant. These independent
variables are therefor removed from the model.

In a second run, the adjusted R2 remains stable at 0.31. The ANOVA shows that
the model is significant (F(5,736)=68.98, p<0.01), meaning that the independent
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variable explains a significant portion of the variation in attitude towards risky
behavior at railway crossings. However, an adjusted R2 of 0.33 can be considered
as rather weak. The coefficients of the independent variables are all significant. It
is therefor decided that no more variables will be remove from the model.

The independent variables that are retained in the model are grade (B=-0.08,
t(736)=2.63, p=0.01), attitude (traffic) (B=0.15, t(736)=4.15, p<0.01),
subjective norm (traffic)(B=-0.07, t(736)=-2.00, p=0.05), attitude (railway
crossings)(B=0.25, t(736)=7.61, p<0.01) and behavioral intention (railway
crossings)(f=0.40, t(736)=12.50, p<0.01).

In other words, a higher grade, a safer attitude in traffic in general and a safer
attitude and behavioral intention at railway crossings predict a safer behavior at
railway crossings in the past. On the contrary, a safer subjective norm in traffic in
general predicts a less safe past behavior at railway crossings.

For the dependent variable behavioral intention (railway crossings), the initial
adjusted R2 equals 0.28. The ANOVA shows that the model is significant
(F(10,728)=30.16, p<0.01). The coefficients of the variables gender (t(728)= -
0.30, p=0.76), grade (t(728)= 1.51, p=0.13), study domain (t(728)= -0.98,
p=0.33), subjective norm (traffic) (t(728)= -0.37, p=0.71), behavior
(traffic)(t(728)= 1.38, p=0.17), attitude (railway crossings) (t(728)= -0.95,
p=0.34) and self efficacy (railway crossings) (t(728)= -0.78, p=0.44) are not
significant. These independent variables are therefor removed from the model.

In a second run, the adjusted R2 remains stable at 0.28. The ANOVA shows that
the model is significant (F(3,738)=97.52, p<0.01), meaning that the independent
variable explains a significant portion of the variation in attitude towards risky
behavior at railway crossings. However, an adjusted R2 of 0.28 can be considered
as rather weak. The coefficients of the independent variables are all significant. It
is therefor decided that no more variables will be remove from the model.

The independent variables that are retained in the model are attitude (traffic)
(B=0.10, t(738)=2.68, p=0.01), perceived behavioral control (traffic)(B=0.17,
t(738)=4.51, p<0.01) and past behavior (railway crossings)(f=0.41,
t(738)=12.44, p<0.01).

In other words, a safer attitude and perceived behavioral control in traffic in
general and safer behavior in the past predict a safer behavioral intention at
railway crossing.
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4.2 Process evaluation: evaluating the live and video testimonials

In the process evaluation, the live and video testimonials that were offered to a
selected group of second and third grade students, are assessed and compared to
each other on cognitive and emotional impact, preference and some qualitative
elements, such as duration, clarity and performance of the speaker.

4.2.1 Evaluation of cognitive and emotional impact

Of the 167 people who indicated they witnessed a testimonial, 66% attended the
live testimonial, while 34% was presented with the videos.

Concerning the cognitive impact of the testimonials, significantly more students
who followed the live testimonial found it credible (p<0.01 on a Pearson Chi-
Square test), useful (p = 0.02), interesting (p<0.01), important (p < 0.01) and
informative (p<0.01) than students who followed the video testimonial. More
specifically, 95.5% of respondents who attended the live testimonial found it
rather or very credible, compared to only 78.9% of video testimonial attendees.
More than two thirds of respondents who witnessed the live testimonial (75.5%)
found it rather or very useful, compared to only 54.4% of video testimonial
viewers. Of the live testimonial attendees, 79.1% found it rather or very
interesting, versus only 52.6% of respondents that were offered the video
testimonial. Almost 9 out of 10 respondents (85.5%) who attended the live
testimonial indicated the story was rather or very important to them, compared
to only 59.6% of video testimonial attendees. Finally, 71.8% of respondents who
attended the live testimonial experienced it to be informative, compared to only
56.1% of video testimonial attendees.

When looking at the emotional impact of the testimonials, 87.3% of respondents
who attended the live testimonial found it rather or very shocking, compared to
only 77.2% of video testimonial attendees. This is a significant difference (p<0.01
on a Pearson Chi-Square test). No significant difference was found for the feelings
“disturbing” (p = 0.49 on a Pearson Chi-Square test) and “frightening” (p = 0.52
on a Pearson Chi-Square test). The proportion of attendees that found the
testimonial rather or very disturbing was 57.3% for the live testimonial and 52.6%
for the video testimonial. The share of attendees that found the testimonial rather
or very frightening was 57.3% for the live testimonial and 57.9% for the video
testimonial.

The percentage of respondents that found the story rather or very shocking is
significantly different for respondents of different birth years (p = 0.52 on a
Pearson Chi-Square test). For example, 100% of students that were born in 2005
found the story rather of very shocking, compared to 83% of respondents born in
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2006, 80% of students born in 2007, 65% of respondents born in 2008 and 31%
for respondents born in 2009. This leads to the conclusion that the younger the
students, the less shocking they find the testimonials, which seems counter
intuitive.

Two constructs were developed, cognitive program impact and emotional program
impact (see also paragraph 3.6.1). The mean scores for these variables are
respectively 3.98 and 3.72, indicating a significantly higher cognitive than
emotional impact, with t(166)=3.84, p<0.01.

There is a significant difference between the students that attended the live
testimonial and those who watched the video testimonial when it comes to
cognitive program impact: t(165)=5.31, p<0.01. The live testimonial has a higher
cognitive program impact (mean=4.18) than the video testimonial (mean=3.59).

Next, the cognitive program impact is examined for differences between
subgroups based on gender and grade. These analyses were performed on the
first post-test dataset, which contains the merged cases for the pre-test and first-
post test. After all, in the first post-test, in which the evaluation questions were
asked, the gender and grade of the respondent were no longer asked. Analyses
can therefore only be performed on the 132 matched cases that received the
evaluation questions (experimental video and live testimonial group).

There is no significant difference between male students and female students
when it comes to cognitive program impact: t(104.12)=-0.11, p=0.91. Also,
among the students who attended the live testimonial, there is no significant
difference in cognitive program impact between male and female students:
t(66.44)=-1.62, p=0.11. Finally, among the students who attended the video
testimonial, there is no significant difference in cognitive program impact between
male and female students t(24.11)=1.21, p=0.24.

There is also no significant difference between 2" and 3™ grade students when it
comes to cognitive program impact: t(38.88)=-1.67, p=0.10. Also, among the
students who attended the live testimonial, there is no significant difference in
cognitive program impact between 2" and 3™ graders: t(4.70)=-0.66, p=0.54.
The low number of 2" graders in this dataset that attended the live testimonial
(n=5) might be part of the cause of the non-existence of a significant difference.
Finally, among the students who watched the video testimonial, there is no
significant difference in cognitive program impact between 2" and 3™ graders
t(43)=0.51, p=0.61.

There is a significant difference between the students that attended the live
testimonial and those who watched the video testimonial when it comes to
emotional program impact: t(115.68)=2.07, p=0.04. The live testimonial has a
higher emotional program impact (mean=3.82) than the video testimonial
(mean=3.53).
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Next, the emotional program impact is examined for differences between
subgroups based on gender and grade. Once again, these analyses were
performed on the first post-test dataset, more specifically on the 132 matched
cases that received the evaluation questions (experimental video and live
testimonial group).

There is a marginally significant difference between male students and female
students when it comes to emotional program impact: t(98.79)=-1.91, p=0.06.
Female students report a higher emotional program impact (mean=3.38) than
male students (mean=3.53). Also, among the students who attended the live
testimonial, there is a marginally significant difference in emotional program
impact between male and female students: t(64.26)=-2.92, p=0.01. Finally,
among the students who attended the video testimonial, there is no significant
difference in cognitive program impact between male and female students
t(31.22)=0.81, p=0.42.

There is a significant difference between 2" and 3™ grade students when it comes
to emotional program impact: t(34.60)=-2.20, p=0.04. Second graders report a
significantly lower emotional program impact (mean=3.31) than 3™ graders
(mean=3.76). However, among the students who attended the live testimonial,
there is no significant difference in emotional program impact between 2" and 3™
graders: t(4.47)=-1.79, p=0.14. The low number of 2" graders in this dataset
that attended the live testimonial (n=5) seems to be the cause of the non-
existence of a significant difference, as the means differ largely (mean=3.83 for
37 graders and mean=3.07 for 2" graders). Finally, among the students who
watched the video testimonial, there is no significant difference in emotional
program impact between 2"? and 3™ graders t(39.69)=-0.56, p=0.58.

4.2.2 Evaluation of the quality of the testimonials

Significantly more respondents who followed the live testimonial found the witness
very good (p < 0.01 on a Pearson Chi-Square test), clear and easy to understand
(p < 0.01 on a Pearson Chi-Square test) than respondents who watched the video
testimonials. Almost two thirds of respondents who attended the live testimonial
(64%) found the witness very good. This is significantly higher than the 30% of
video testimonial attendees that found the witness very good. Furthermore, 68%
of respondents who witnessed the live testimonial found the witness very clear
and clearly understandable, significantly more than the 11% of those students
that watched the video testimonials.

Only 5.5% of respondents who attended the live testimonial would rather have
followed the video testimonials. This is significantly lower than the 64.9% of video
testimonial attendees that would rather have attended the live testimonial.
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There is a significant difference between the live and the video testimonial when
it comes to the perceived duration of the testimonial (p < 0.01 on a Pearson Chi-
Square test). Only 1.2% of respondents who attended the live testimonial found
the duration of the testimonial too short, compared to 15.8% of video testimonial
viewers. Thirty percent of respondents of the live testimonial attendees found the
duration too long, compared to 21.1% of those who watched the video testimonial.
In this respect, it is important to mention, that the live testimonial actually lasted
longer than the 30 minutes that were anticipated and mentioned in the survey
question. The actual duration of the live testimonial was more or less 45 minutes.

The answers on the open-ended questions that tried to find out what respondents
remembered most about and what they would recommend for both the live and
video testimonial reveal that the sound and therefore the comprehensibility of the
video testimonial was not good. Furthermore, the humor and positivity of the
speaker, that many who had followed the live testimonial remembered, was
mentioned as a recommendation for the video testimonial, in which this humour
was much less present.

4.3 Effect evaluation: evaluating the effect of the live and video
testimonials (pre-test-post-test analysis for the first post test)

To evaluate the possible effect of the testimonials presented to the students in the
experimental group, a repeated measures MANOVA was performed for the socio-
cognitive and behavioral variables with regard to traffic safety in general and a
repeated measures ANOVA was conducted on the socio-cognitive and behavioral
variables with regard to safety at railway crossings in general. The following
paragraphs describe in detail the steps that were taken during the analysis and
the results these steps produced. A first paragraph focuses on the evaluation of
the effect between the pre-test and the first post-test. Differences between the
effect of the live testimonial and the video testimonial are compared with the
evolution in the control group. This analysis is performed on the first post-test
dataset (n=197). In the second paragraph, the focus lies on the evaluation of the
effect between the pre-test, the first post-test and the second post-test, which is
only considered for the variables that produced a significant effect after the first
post-test. This analysis is performed on the first post-test dataset (n=77).

4.3.1 Effect of the live and video testimonial on socio-cognitive and behavioral
variables with regard to traffic safety in general

In a first step of the analysis, a repeated measures MANOVA was performed on
the variables attitude (traffic), subjective norm (traffic), perceived behavioral
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control (traffic), behavioral intention (traffic) and behavior (traffic). A marginally
significant multivariate within subject interaction effect was found: F(5,190) =
3.54, p = 0.09. It was decided upon to further analyse this marginal effect. This
showed a significant univariate within subject interaction effect for subjective
norm (traffic) (F(2,194) = 5.07, p = 0.01) and a marginally significant univariate
within subject interaction effect for behavioral intention (traffic): F(2,194) = 2.42,
p = 0.09.

For both of these variables, extra analyses were performed to better understand
the (marginal) effects that arose. The possible significant difference between pre-
test and post-test for each of these groups was examined by repeating the
repeated measure MANOVA on the different groups separately (the Split File
function in SPSS was used to separate the group results). Only the variables for
which there is 1) no significant difference for the control group between pre-test
and post-test and 2) a significant effect on either the live testimonial experimental
group or the video testimonial experimental group or both, are considered to
represent a noteworthy effect on the examined variables.

Figure 6 gives a visualisation of the evolution of the means for the difference
groups for the variable subjective norm (traffic).
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Figure 6 - Visualisation of mean scores of the variable subjective norm (traffic) in the
pre-test and the first post-test

The repeated measures MANOVA for each group separately (Split File) showed
that there is a significant difference between the means of the pre-test and the
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post-test for the control group: F(5,60) = 2.77, p = 0.03 for the multivariate
within subject effect and F(1,64) = 4.70, p = 0.03 for the univariate within subject
effect with means decreasing from 3.35 to 3.27. Furthermore, a significant
difference between the means of the pre-test and the post-test for the live
testimonial experimental group was found: F(5,82) = 2.76, p = 0.02 for the
multivariate within subject effect and F(1,86) = 5.8, p = 0.02 for the univariate
within subject effect with means increasing from 3.38 to 3.47. However, there was
no significant difference between the means of the pre-test and the post-test for
the video testimonial experimental group: F(5,40) =1.35, p = 0.26 for the
multivariate within subject effect. It can therefore be concluded that the effect
that was shown in the repeated measures MANOVA is significant because there is
a significant positive effect for the live testimonial experimental group, while the
means of the control group also significantly.

The effect on the variable subjective norm (traffic) is therefore not taken into
account.

Figure 7 gives a visualisation of the evolution of the means for the difference
groups for the variable behavioral intention (traffic).
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Figure 7 - Visualisation of mean scores of the variable behavioral intention (traffic) in
the pre-test and the first post-test
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The repeated measures MANOVA for each group separately (Split File) also
showed that there is a significant difference between the means of the pre-test
and the post-test for the control group: F(5,60) =2.77, p = 0.03 for the
multivariate within subject effect and F(1,64) =5.20, p = 0.03 for the univariate
within subject effect with means decreasing from 3.79 to 3.60. A significant
difference between the means of the pre-test and the post-test for the live
testimonial experimental group was not found: F(5,82) =2.77, p = 0.02 for the
multivariate within subject effect and F(1,86) <0.01, p = 0.96 for the univariate
within subject effect. There was also no significant difference between the means
of the pre-test and the post-test for the video testimonial experimental group:
F(5,40) =1.35, p = 0.26 for the multivariate within subject effect. It can therefore
be concluded that the marginally significant effect that was shown in the repeated
measures MANOVA is caused by a significant decrease of the means of the control
group. Furthermore, there is a significant difference between the three groups on
the pre-test.

The effect on the variable behavioral intention (traffic) is therefore not taken into
account. It can be concluded that the live and the video testimonials have no effect
on the socio-cognitive and behavioral variables with regard to traffic safety in
general.

In the first step of the analysis, the repeated measures MANOVA, the variables
attitude (traffic), perceived behavioral control (traffic) and behavior (traffic) did
not have a significant univariate within subject interaction effect: resp. F(2,194)
= 1.38, p = 0.25; (2,194) = 1.57, p = 0.21; and F(2,194) = 1.03, p = 0.36. For
these variables, the main effects for group (live and video testimonial
experimental group and control group) and measurement (pre-test and post-test)
are examined.

For the main effect for group, the multivariate between-subject effect for group
appears to be significant (F(10,382) = 4.67, p < 0.01). For the variable behavior
(traffic) the univariate between-subject effect for group is also significant:
F(2,194) = 6.97, p < 0.01. This indicates that for both measurements the control
group has a significantly lower average than the live and video testimonial
experimental group.

When examining the main effect for measurement, the univariate within subject
effect for the variable behavior (traffic) does also appear to be significant:
F(1,194) = 7.93, p = 0.01. This indicates that for the three groups the mean score
is significantly lower in the second measurement (post-test) than in the first
measurement (pre-test).

For the variable attitude (traffic), the main effect for measurement, as presented
by the univariate within subject effect, is also significant: F(1,194) = 6.74, p =
0.01. This indicates that for the three groups the mean score is significantly lower
in the second measurement (post-test) than in the first measurement (pre-test).
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For the variables attitude (traffic) and perceived behavioral control (traffic) the
main effect for group is not significant: resp. F(2,194) = 1.40, p = 0.25 and
F(2,194) = 0.87, p = 0.42. The main effect for measurement is also not significant
for the variable perceived behavioral control: F(1,194) = 0.02, p = 0.88.

4.3.2 Effect of the live and video testimonial on socio-cognitive and behavioral
variables with regard to traffic safety at railway crossings

As opposed to the variables with regard to traffic safety in general, the variables
attitude (railway crossings), behavioral intention (railway crossings) and self
efficacy were analysed separately, using a repeated measures univariate ANOVA.
Whereas the variables with regard to traffic safety in general were treated as a
group because they originate from a previous study (Cuenen et al., 2016), the
variables with regard to railway crossings were constructed for this study.
Therefore, assumptions on interconnection between them were not made.

When a significant univariate within subject interaction effect was found in the
repeated measures univariate ANOVA for these variables, extra analyses were
performed to better understand the (marginal) effects that arose. The possible
significant difference between pre-test and post-test for each of these groups was
examined by repeating the repeated measure univariate ANOVA on the different
groups separately (the Split File function in SPSS was used to separate the group
results). Only the variables for which there is 1) no significant difference for the
control group between pre-test and post-test and 2) a significant effect on either
the live testimonial experimental group or the video testimonial experimental
group or both, are considered to represent a noteworthy effect on the examined
variables.

For the variable attitude (railway crossings), a significant within subject interaction
effect was found: F(1,184) =3.19, p = 0.04.

Figure 8 gives a visualisation of the evolution of the means for the difference
groups for the variable attitude (railway crossings).
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Figure 8 - Visualisation of mean scores of the variable attitude (railway crossings) in the
pre-test and the first post-test

The repeated measures univariate ANOVA for each group separately (Split File)
showed that there is no significant difference between the means of the pre-test
and the post-test for the control group: F(1,59) =0.64, p = 0.43 for the within
subject effect. However, a significant difference between the means of the pre-
test and the post-test for the live testimonial experimental group was found:
F(1,84) =9.39, p = 0.03 for the within subject effect with means increasing from
4.08 to 4.30. There was also a marginally significant difference between the means
of the pre-test and the post-test for the video testimonial experimental group:
F(1,41) =2.87, p = 0.10 for the within subject effect with means increasing from
3.99 to 4.19. It can therefore be concluded that the effect that was shown in the
repeated measures univariate ANOVA is significant because there is a significant
positive effect for the live testimonial experimental group and a marginally
significant positive effect for the video testimonial experimental group. Phrased
differently, the live testimonial has a significant positive effect on the attitude
towards risky behavior at railway crossings of the respondents. The video
testimonial has a marginally significant effect.

For the variable behavioral intention (railway crossings), a marginally significant
within subject interaction effect was found: F(2,181) =2.85, p = 0.06.

Figure 9 gives a visualisation of the evolution of the means for the difference
groups for the variable behavioral intention (railway crossings).
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Figure 9 - Visualisation of mean scores of the variable behavioral intention (railway
crossings) in the pre-test and the first post-test

The repeated measures univariate ANOVA for each group separately (Split File)
showed that there is no significant difference between the means of the pre-test
and the post-test for the control group: F(1,58) = 1.27, p = 0.27 for the within
subject effect. However, a significant difference between the means of the pre-
test and the post-test for the live testimonial experimental group was found:
F(1,83) =4.63, p = 0.03 for the within subject effect with means increasing from
4.02 to 4.27. There was no significant difference between the means of the pre-
test and the post-test for the video testimonial experimental group: F(1,40)
=0.30, p = 0.86 for the within subject effect. It can therefore be concluded that
the effect that was shown in the repeated measures univariate ANOVA is
significant because there is a significant positive effect for the live testimonial
experimental group. Phrased differently, the live testimonial has a significant
positive effect on the behavioral intention towards risky behavior at railway
crossings of the respondents. Such an effect is not found for the video testimonial.

For the variable self efficacy, no significant within subject interaction effect was
found in the repeated measures univariate ANOVA: F(1,179) =0.17, p = 0.84. The
effect on this variable is therefore not taken into account. The main effects for
measurement and group were also not significant: resp. F(1,180) = 0.55, p =
0.46 for the within subject effect and F(1,180) = 1.93, p = 0.17 for the between-
subject effect.
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4.4 Effect evaluation: evaluating the effect of the live and video
testimonials (pre-test-post-test analysis for the second post test)

A repeated measures univariate ANOVA for 3 measurements (pre-test, post-test
1 and post-test 2) and 3 groups (control group, live testimonial experimental
group and video testimonial experimental group) was performed on the variables
attitude (railway crossings) and behavioral intention (railway crossings), as these
were the only variables on which a significant effect was shown after the first post-
test (see paragraph 4.3).

For the variable attitude (railway crossings), no significant within subject
interaction effect was found in the repeated measures univariate ANOVA:
F(3.59,125.52) =0.54, p = 0.69. The effect on this variable is therefore not taken
into account. The main effect for measurement is significant: F(1.79,125.52)
=4.25, p = 0.02 for the within subject effect. A pairwise comparison learns that
there is a significant main effect for measurement between the pre-test and the
first post-test for all groups together. The mean score on the first measurement
is lower than the mean score on the second measurement. F(2,70) =0.84, p =
0.44 for the between-subject effect.

Figure 10 gives a visualisation of the evolution of the means for the difference
groups for the variable attitude (railway crossings).
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Figure 10 - Visualisation of mean scores of the variable attitude (railway crossings) in
the pre-test, the first post-test and the second post-test
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For the variable behavioral intention (railway crossings), a marginally significant
within subject interaction effect was found: F(3.83,130.32) =2.40, p = 0.06.

Figure 11 gives a visualisation of the evolution of the means for the difference
groups for the variable behavioral intention (railway crossings).
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Figure 11 - Visualisation of mean scores of the variable behavioral intention (railway
crossings) in the pre-test, the first post-test and the second post-test

The repeated measures univariate ANOVA for each group separately (Split File)
showed that there is no significant difference between the means of the different
measurements for the control group: F(1.96,48.87) =0.61, p = 0.55 for the within
subject effect. However, a significant difference between the means of the
different measurements for the live testimonial experimental group was found: F
F(1.95,48.86) =6.62, p < 0.01 for the within subject effect with means increasing
from 3.96 in the pre-test to 4.40 in the first post-test (which is a significant rise,
p=0.01) and slightly decreasing to 4.36 in the second post-test (which is no
significant decline, p=1.00). There was no significant difference between the
means of the different measurements for the video testimonial experimental
group: F(1.34,24.15) =0.40, p = 0.59 for the within subject effect. It can therefore
be concluded that the effect that was shown in the repeated measures univariate
ANOVA is significant because there is a significant positive effect for the live
testimonial experimental group. Because the mean score remains stable between
the first and the second post-test, it can be stated that the live testimonial has a
significant positive effect on the behavioral intention towards risky behavior at
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railway crossings of the respondents that remains stable after a month. Such an
effect is not found for the video testimonial.
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5 Discussion

As stated in chapter 2 Objectives and research questions, the two most important
goals for this study are 1) to examine how serious the problem of unsafe behavior
at railway crossings is among young people and therefore how great the need is
for using testimonies as an intervention tool (measurement of behavior); 2) to
examine which variables predict attitudes and behavior at railway crossings; 3) to
carry out an evaluation of a live and video testimonial, in order to find out how
they are assessed by the participants (process evaluation) and 4) to evaluate what
effect these live and video testimonial have on (socio-cognitive determinants of)
the behavior of young people at railway crossings (effect evaluation).

This chapter attempts to formulate an answer to all research questions that were
formulated in paragraph 2.2. To improve clarity, this is done separately for the
measurement of behavior, the process evaluation and the effect evaluation and
for the different sub questions.

5.1 Measurement of (socio-cognitive determinants of) behavior in
traffic in general and at railway crossings in particular

The key research question for the measurement of behavior in traffic in general
and at railway crossings is:

“How serious is the problem of unsafe behavior at railway crossings among young
people?”

The following sub questions are defined:

¢ How safe is/are the (socio-cognitive determinants of) behavior of the target
group, for general road safety?

e Is there a significant difference in these/this (socio-cognitive determinants
of) behavior in traffic in general between subgroups based on gender, grade
and study domain?

¢ How safe is/are the (socio-cognitive determinants of) behavior of the target
group, for safety at railway crossings in particular?

e Is there a significant difference in these/this (socio-cognitive determinants
of) behavior at railway crossings between subgroups based on gender,
grade and study domain?

e How high is the level of exposure of youth in Flanders to railway crossings?
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5.1.1 Research question 1: How safe is/are the (socio-cognitive determinants
of) behavior of the target group, for general road safety?

Based on the results of this study, it is difficult to determine if young people are
safe in traffic or not. Quite a few respondents have already received a traffic fine
and a third of them have been involved in an accident. The latter does not
necessarily mean that the target group is unsafe in traffic. After all, it is not clear
whether the respondents who experienced an accident actively participated in
traffic themselves or as a passenger and, if they did actively participate in traffic
themselves, whether they were at fault in the accident or not. Based on the scores
on the socio-cognitive determinants of traffic behavior, it is also difficult to
determine whether the target group of this study has safe attitudes and habits in
traffic. After all, there is practically no basis for comparison with other age groups.

As the variable concerning traffic safety in general are based on the answers of
the respondents on a 5-point Likert scale with exactly the same list of items as in
Cuenen et al. (2016), it is useful to compare the mean scores of both studies. It
must be taken into account that the mean scores on the variables in Ceunen et al.
(2016) have the opposite meaning as the mean scores in this study. A higher
score in Cuenen et al. (2016) means a less safety supportive attitude or behavior.
In this study it is the other way around. On a 5-point scale, the minimum score is
1 and the maximum score is 5. A value of 5 on the first scale therefore corresponds
to a value of 1 (=6-5) inverted scale. To reverse the scores, the mean score from
Ceunen et al. (2016) must be subtracted from 6.

The (converted) mean score in Cuenen et al. (2016) is significantly higher (and
thus safer) for attitude about traffic safety in general (t(1419)=5.19, p<0.01).
However, the mean score for behavior in traffic in general in Cuenen et al. is
significantly lower and thus less safe than in this study (t(1419)=13.65, p<0.01).
These (counterintuitive) differences might be caused by differences in the target
group. In Cuenen et al. (2016), only 3™ graders are included, and the distribution
based on gender and study domain is more balanced than in this study. Cuenen
et al (2016) consider the students in their study to be already quite road safety
supportive.

5.1.2 Research question 2: Is there a significant difference in these/this (socio-
cognitive determinants of) behavior in traffic in general between
subgroups based on gender, grade and study domain?

What does clearly emerge from the results of this study is that older students (3™
grade) score better across the board than their younger fellow students (2"
grade). This is in line with Steinberg (2020), who indicates that the increased
propensity towards risky decision making in adolescents only starts to decrease
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from 14-15 years, an age category that corresponds to that of students in the 2™
grade. The only variable for which 2" and 3™ graders do not differ is subjective
norm (traffic). However, the score on this variable is very close for all subgroups
examined. Also, when it comes to experience with receiving a fine or involvement
in an accident, there are no differences between age groups. The safer behavior
of the 3™ grade students may be offset by increased exposure and vulnerability.
After all, the results indicate that older students cycle to school significantly more
often. Wex et al. (2023) confirm that older students more often cycle to school.

In contrast with Cuenen et al. (2016) female students are not significantly more
traffic safety supportive than male students on all examined variables. Only for
attitude (traffic) and perceived behavior control (traffic) this is the case.

This contradicts what has been shown in many other studies, namely that
engaging in risky behavior is more likely for men than for women, in life in general
(Harris, 2006; Clancy et al., 2007) and for young men than for other road users
in traffic in particular (Yagil, 1998; Heidstra, 2007 ; Paljat & Delhomme, 2012;
Goldenbeld et al., 2018; Wang H. et al., 2018,; Wang C. et al., 2020).

The results also differ slightly from those from Ceunen et al. (2016) when looking
at the differences between study domains. In this study, just as in Ceunen et al.
(2016), it can be concluded that students of general education/throughflow finality
and of technical education/double finality are significantly more road safety
supportive than students of occupational education/labour market finality with
regard to behavioral intention (traffic) and behavior (traffic). In contrast to
Cuenen et al. (2016), this significant difference between study domains for the
variables attitude (traffic) and subjective norm (traffic) does not show in this
study. For this last variable, Cuenen et al. (2016) only showed a difference
between general education and occupational education. For the variable perceived
behavioral control (traffic), the results show that students from general
education/throughflow finality are significantly more road safety supportive than
students from technical education/double finality and occupational
education/labour market finality. In Cuenen et al. (2016), no significant difference
was found between the different study domains for this variable.

5.1.3 Research question 3: How safe is/are the (socio-cognitive determinants
of) behavior of the target group, for safety at railway crossings in
particular?

As with traffic safety in general, it is difficult to determine if young people are safe
at railway crossings or not, based on the mean scores that emerge in this study
on the socio-cognitive variables concerning behavior at railway crossing. Mean
scores of 4.05 on attitude (railway crossings) and 4.50 on past behavior (railway
crossings) seem quite high. However, they need to be viewed within a perspective
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in order to be able to make sensible statements about safety at railway crossings.
When looking at the seven different forms of risky behavior at railway crossings,
that were presented separately to the students in the surveys and later
aggregated into the different socio-cognitive variables, a better picture of the risky
behavior of young people at railway crossings is obtained.

For example, 5.2% of the students do not think it is dangerous to cross a railway
crossing when the red lights are flashing, and the barriers are completely closed.
Moreover, 4.2% indicate that they have done it at least once a month for the past
6 months. In addition, even 12.2% indicate that they are likely or very likely to
do so in the future. These percentages become even greater when looking at the
transition phases where the barriers are raised or lowered and when looking at
behavior or circumstances that cause distraction. For example, 8.7% do not think
it is dangerous to cross a railway crossing when a train has just passed, but before
the barriers are completely open and the red lights are still flashing, 5.2% have
done it at least once a month for the past 6 months even 13.8% says they are
likely or very likely to do so in the future. When looking at the risky behavior of
crossing a railway crossing when hearing is impaired (e.g. listening to music
through headphones), 14% do not think it is dangerous, 12.9% indicate they have
done it at least once a month for the past 6 months and as many as 27.1% says
they are likely or very likely to do so in the future.

Since the questions about past behavior and about the attitude and intention
towards risky behavior at railway crossings are inspired by the Railspect study,
which GfK carried out for Infrabel, it is worthwhile to compare the results of both
studies. In the available cross-tables of the Railspect study the subgroup of 15 to
24-year-olds was considered for maximum comparability. When comparing it is
immediately clear that the Railspect study shows safer results across the board.
This applies to both attitude and past behavior (behavioral intention was not
surveyed in that study). In the case of attitude, the share of respondents that
considers the presented risk behavior rather not or not at all dangerous is
considerably lower in the Railspect study than in this study. For past behavior,
both the share of respondents who have done the behavior more than once per
month over the past 6 months and the share of respondents who have done the
behavior more than once per week over the past 6 months, are larger in this study
than in the Railspect study. Since both studies were conducted online, the
difference in results is probably caused by the difference in the age of the target
group. This seems to show that risky behavior at railway crossings decreases even
further after the 3™ grade of secondary education and thus that interventions in
secondary school are very needed. The two studies also differ with regard to
geographic focus. While this study only attempts to make a statement about
Flemish young people and only conducts research among students in the province
of Limburg, the Railspect study is organized nationally, with "only" 58% of the
respondents living in Flanders. Circumstantial differences between the Belgian
regions (Flanders, Brussels and Wallonia) might have an impact on the risky
behavior at railway crossings.
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5.1.4 Research question 4: Is there a significant difference in these/this (socio
cognitive determinants of) behavior at railway crossings between
subgroups based on gender, grade and study domain?

Male students tend to engage in risky behavior at railway crossings more than
female students. This applies to their attitude towards (un)safe behavior and to
past behavior. However, they score better than their female counterparts on self-
efficacy, their own belief in their ability to behave safely at railway crossings. There
are only limited significant differences when it comes to behavioral intention.
Female students report a lower likelihood than male students of crossing a railroad
crossing while using their smartphone. The increased engagement in risky
behavior of males at railway crossings is confirmed by Clancy et al. (2007), Edquist
et al. (2011), Freeman et al. (2013), Stefanova et al. (2015) and SAFER-LC D2.1
(2018).

Students in the 2" grade exhibit a significantly less safe attitude, behavioral
intention and self-efficacy at railway crossings. Only in terms of past behavior no
significant difference is found between 2" and 3™ grade students. When looking
at crossing a railway crossing when hearing is impaired (e.g., by listening to music
through headphones), 3™ grade students even did it more often in the past. Past
behavior is of course partly determined by the extent to which students come into
contact with railway crossings. Exposure is significantly higher for 37 graders than
for 2" graders, both during trips between home and school and on other
occasions. Clancy et al. (2007) found that familiarity with railway crossings is one
of the main factors leading to accidents because of an increased complacency.

The increased engagement in risky behavior of 2"d graders at railway crossings
can again be linked to the findings of Steinberg (2020), who stipulates that the
increased inclination towards risky decision making in adolescents is at its peak at
the age of 14-15 years, which corresponds with the age category of students in
the 2" grade. That this increased risk behavior for second graders also applies to
railway crossings is consistent with the findings of Stefanova et al. (2015), that
crossing a railway crossing behind a stopped train and after the gates are closed
were associated with younger adults.

The results show no significant differences between the different study domains
with regard to the socio-cognitive variables attitude, behavioral intention, past
behavior and self-efficacy. When looking at the different types of behavior, do
significant differences between the study domains can be seen, but no general
direction of the difference can be determined. For example, throughflow finality
students have a significantly safer attitude than labor market finality students
towards crossing a railway crossing when the red lights are flashing, and the
barriers are completely closed. However, labor market finality students have a
significantly safer attitude than throughflow finality students towards crossing a
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railway crossing when a train has just passed, but before the barriers are
completely open and the red lights are still flashing. What is remarkable is that
past behavior for all the different types of behavior is not significant across study
domains.

5.1.5 Research question 5: How high is the level of exposure of youth in
Flanders to railway crossings?

The need for interventions can also be demonstrated by considering young
people's exposure to railway crossings. As mentioned earlier, Clancy et al. (2007)
states that familiarity with railway crossings leads to increased complacency and
to more accidents. The results of this study show that half of the respondents have
to cross a railway crossing on the way to school. When crossing railway crossings
in other circumstances than the commute to school is added to the equation,
almost 80% of respondents is at least once in a while exposed to railway crossings.
Almost 40% of the time this exposure happens either by foot, by bike or by mope.
Also, nearly half of the respondents live within one kilometre of a railway crossing.
The results of this study show that a students that are exposed to railway
crossings, either on their (school or non-school) trips or because they live in the
vicinity they live in the vicinity of a railway crossing, have shown more unsafe
behavior (in the past) and in the case of living near a railway crossing also a less
safe attitude towards risky behavior at railway crossings.

The high level of exposure is of course at least partially caused by the fact that
both schools have been purposefully selected because of their proximity to a
railway crossing. However, the list of schools located at a maximum distance of
400 meters from a railway crossing (see section 3.2) shows that the schools that
participated in this study are not exceptional, even in a region with a relatively
low density of the railway network.

5.2 Search for factors that predict attitudes and behavior at railway
crossings

The key research question for the search into factors that predict attitudes and
behavior at railway crossings, is:

“Which variables are able to predict attitudes, past behavior and behavioral
intention at railway crossings?”

The following sub questions are defined:
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o Which socio-demographical variables are able to predict attitudes,
past behavior and behavioral intention at railway crossings?

o Which socio-cognitive variables are able to predict attitudes, past
behavior and behavioral intention at railway crossings?

5.2.1 Research question 6: Which socio-demographical variables are able to
predict attitudes, past behavior and behavioral intention at railway
crossings?

The results of the linear regression analysis, show that the socio-demographical
variables gender, grade and study domain are not good at predicting attitudes,
past behavior and behavioral intention at railway crossings. The variables gender
and study domain are not able to explain the variation in any of the examined
dependent variables. The variable grade is positively correlated with past behavior
at railway crossings. In other words, the higher the grade, the safer the behavior
at railway crossings in the past. This indicates that 2" graders are more at risk
than 1%t graders.

5.2.2 Research question 7: Which socio-cognitive variables are able to predict
attitudes, past behavior and behavioral intention at railway crossings?

The Theory of Planned Behavior (Ajzen, 1985) was already mentioned in
paragraph 1.2.1 as a widely applied framework to understand behavior. It states
that a person’s behavior is a result of this person’s intention to perform that
behavior, which is in turn a result of the person’s attitudes, perceived behavioral
control and subjective norms. This framework has often been applied in studies
on road safety (e.g., Barton et al., 2016; Floreskul et al., 2016), even for studies
on victim testimonials (e.g., Feenstra et al., 2014; Cuenen et al., 2016), but rarely
in studies on (un)safe behavior at railway crossings. However, Baric et al. (2020)
and Palat et al. (2017) have applied the Theory of Planned Behavior to behavior
at railway crossings.

In the results of this study, the socio-cognitive variable attitude towards safety at
railway crossings appears to be a good predictor of past behavior, but not of
behavioral intention at railway crossings. This contradicts what emerges in Baric
et al. (2020) and Palat et al. (2017), namely that attitude toward railway crossing
risk significantly predicts intentions for risky driving behavior at railway crossings.

In addition, attitude towards traffic safety in general is a good predictor of both
(un)safe attitude, (un)safe past behavior and behavioral intention towards
(un)safe behavior at railway crossings. The relationships between attitude towards
traffic safety in general and the three examined dependent variables is a positive
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one. This is in line with what emerges in Baric et al. (2020), namely that attitude
toward safety in traffic in general significantly predicts intentions for risky driving
behavior at railway crossings. It is therefore important to focus not only on
interventions aimed at changing attitudes about unsafe behavior at railway
crossings, but also attitudes about road traffic safety in general.

Another good predictor is past behavior at railway crossings. It has a positive
relationship with both the attitude towards safety at railway crossing and
behavioral intention at railway crossings. The more a student has displayed
(un)safe behavior in the past, the more (un)safe the attitude towards safety at
railway crossings and the more the student intends to continue to display unsafe
behavior at railway crossings in the future. It is therefore extra important to focus
on changing the behavior of students at railway crossings by offering
interventions, such as testimonials. This is in line with what Baric et al. (2020)
found, namely that self-reported frequency of risky crossing was the main
predictor of the intention to commit this violation again in the future.

Subjective norm (traffic) and perceived behavioral control (traffic) are socio-
cognitive variables for which the results are contradictory. The independent
variable subjective norm (traffic) has a positive relationship with the dependent
variable attitude (railway crossings), and a negative relationship with the
dependent variable past behavior (railway crossings). Palat et al (2017) indicate
that subjective norm significantly predicts intentions for risky driving behavior at
railway crossings, an effect that is not found in the results of this study. Perceived
behavioral control (traffic) has a negative relationship with attitude (railway
crossings), but a positive one with behavioral intention (railway crossings).

5.3 Process evaluation

The key research question for the process evaluation is:

“How do participants evaluate the presented live and video testimonials on
cognitive and emotional aspects and some qualitative elements and which format
do they prefer?"

The following sub questions are defined:

e How do the members of the target group assess the presented live
testimonial on cognitive and emotional elements and some qualitative
elements, such as duration, clarity and performance of the speaker?

¢ How do the members of the target group assess the presented video
testimonial on cognitive and emotional elements and some qualitative
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elements, such as duration, clarity and performance of the speaker? Is
there a significant difference with the assessment of the live testimonial?

5.3.1 Research question 8: How do the members of the target group assess the
presented live testimonial on cognitive and emotional elements and some
qualitative elements, such as duration, clarity and performance of the
speaker?

The live testimonial is rated very well, especially on the cognitive elements, such
as credibility, importance, interestingness, usefulness and informativeness.
Respondents also find the testimonial shocking, but not really disturbing and
frightening.

One of the possible explanations for these good scores is the strong identification
with the speaker. Feenstra et al. (2014) and Bojesen & Rayce (2020) state that
identifiability is important for the personal susceptibility and confidence in one's
own ability to avoid or prevent accidents in their own situation. In this study the
identifiability seems to be very good: the speaker was not much older than the
audience at the time of the accident, he comes from the same region as the
audience, the accident happened on the way back from a party (which ties in with
the audience's lifeworld), ... The humor that the speaker uses also contributes to
the identifiability.

The mean scores for cognitive and emotional program impact of the live
testimonial are respectively 4.18 and 3.82, indicating a significantly higher
cognitive than emotional impact, with t(109)=4.72, p<0.01. This corresponds to
the results of Cuenen et al. (2016), in which the respondents were also more
cognitively than emotionally affected. The mean scores in that study were 1.36
and 2.16, which, once again, are based on a reverse 5-point scale as in this study.
As for the variables concerning traffic safety in general, the mean scores Ceunen
et al. (2016) must be subtracted from 6 in order to make a comparison (see also
5.1.1). The inverted mean score for cognitive program impact is 4.64, which is
significantly higher than the mean score for the cognitive program impact for this
study (t(812)=8.14, p<0.01). The inverted mean score for emotional program
impact is 3.84, which is not significantly different than the mean score for the
emotional program impact for this study (t(812)=0.23, p=0.82). The significantly
higher emotional and cognitive impact for female students, which was found in
Cuenen et al. (2016), was only (marginally) found for the emotional impact of the
live testimonial in this study.
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5.3.2 Research question 9: How do the members of the target group assess the
presented video testimonial on cognitive and emotional elements and
some qualitative elements, such as duration, clarity and performance of
the speaker? Is there a significant difference with the assessment of the
live testimonial?

From the results it is immediately clear that there is a notable difference between
the live and video testimonials. The video testimonial scores much lower than the
live testimonial. It is considered significantly less credible, important, interesting,
useful, informativeness and also less shocking.

One of the possible explanations for the poor scores given by respondents to the
video testimonial is that video is less personal. In a sense, there is a greater
distance between the speaker and the viewer of the video because there is no
direct contact. The message is less well conveyed, which is shown in the lower
score on cognitive program impact, but the emotions also come across less well,
which is reflected in a marginally significant difference in emotional program
impact. The speaker also uses less humor, which is a strength of the live
testimonial and part of the core message "whatever happens, stay positive."

The mean scores for cognitive and emotional program of the video testimonial
impact are respectively 3.59 and 3.53, indicating no significant difference between
cognitive and emotional impact, with t56)=0.47, p=0.07. This differs from the
results from the live testimonial and from the results of Cuenen et al. (2016), in
which the respondents were more cognitively than emotionally affected. The
inverted mean score for cognitive program impact in that study is 4.64, which is
significantly higher than the mean score for the cognitive program impact for this
study (t(759)=13.49, p<0.01). The inverted mean score for emotional program
impact is 3.84, which is significantly higher than the mean score for the emotional
program impact for the video testimonial in this study (t(759)=2.67, p=0.01). The
significantly higher emotional and cognitive impact for female students, which was
found in Cuenen et al. (2016), was not found for the emotional impact of the video
testimonial in this study.

Compared with respondents who followed the live testimonial, significantly less
respondents that watched the video testimonial found the witness very good, clear
and easy to understand. This is ultimately reflected in the significantly higher
preference for live than for video testimonial.

Furthermore, the impact of the video testimonial is lower, both for cognitive and
emotional impact. Significantly less students who watched the video testimonial
found it credible, useful, interesting, important, informative and shocking than
students who attended the live testimonial. When looking at the constructed
variables cognitive and emotional program impact, it is not surprising that the
video testimonial has a significantly lower impact for both aspects.
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5.4 Effect evaluation

The key research question for the effect evaluation is:

e Can the presented live and/or video testimonial help to change the (socio-
cognitive determinants of) behavior of the target group with regard to risky
behavior at railway crossings?

The following sub questions are defined:

o Can an effect of the live and/or video testimonial be observed
immediately after offering these testimonials to the respondents?

o Can an effect of the live and/or video testimonial be observed one
month after offering these testimonials to the respondents?

5.4.1 Research question 10: Can an effect of the live and/or video testimonial
be observed immediately after offering these testimonials to the
respondents?

The results in paragraph 4.3.1 show that no significant effect was established on
the variables with respect to traffic safety in general: attitude, subjective norm,
perceived behavioral control, behavioral intention and behavior were not affected
by the live nor the video testimonial. It can there for be concluded that the live
and the video testimonials have no effect on the socio-cognitive and behavioral
variables with regard to traffic safety in general.

With regard to safety at railway crossing, only three of the initial four variables
were examined: attitude, self efficacy and behavioral intention. The variable past
behavior was not examined, because incorrect answer categories were added in
the first post-test and because past behavior that is surveyed over different
periods (6 months, 1 week, 1 month) is difficult to compare.

The results show that the live testimonial has an immediate significant positive
effect on both the attitude and the behavioral intention towards risky behavior at
railway crossings of the respondents.

The video testimonial only has a marginally significant effect on attitude towards
viewers risky behavior at railway crossings immediately after the presentation of
the videos and no immediate significant effect on behavioral intention of the
viewers.

To date, effect studies of road safety programs using video testimonials among
youngsters are very scarce. No study was found in which the effect of video
testimonials was examined on risky behavior at railway crossings.
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For traffic behavior in general, Putranto & No (2017) indicate that 5 minute
testimonial video (either performed by real accident victim or by professional
artist) were able to change the behavioral intention of young Indonesian
motorcyclists towards safe motorcycling behaviors such as buckling the chin strap
of their helmet, wearing bright colour jacket, wearing gloves and shoes and
obeying the speed limit. In other sectors, such as healthcare and general safety,
more evidence can be found that video testimonials can have an effect on
behaviors such as smoking by adolescents (Fitrianto et al., 2023), end-of-life-care
by healthcare professionals (Mirarchi et al., 2017), patients fear reduction (Shor
et al., 2023) and children’s drowning prevention (Shen et al., 2016).

Effect studies of road safety programs using live testimonials among youngsters
are easier to find. However, they also do not focus on traffic safety at railway
crossing but look for the effect on traffic safety attitudes and behavior in general.
The results of these studies are rather ambiguous.

King et al. (2008), Poulter & McKenna (2010), Glendon et al. (2014), and Ceunen
et al. (2016) conducted research into the immediate effect of a live testimonial,
by administering a post-test survey that was presented to the students shortly
after the intervention. Like this study, King et al. (2008), Poulter & McKenna
(2010) and Ceunen et al. (2016) found an immediate positive effect on attitude.
However, for the last two studies, the effect was small. Glendon et al. (2014) even
find a counterintuitive effect, namely attitudes that became less traffic safety
supportive. However, in the study by Glendon et al. (2014), the live testimonial
was part of a mixed program of interventions, making the comparison slightly less
obvious.

The other variable that experiences an immediate significant effect from the live
testimonial in this study, behavioral intervention, is only mentioned in the short-
term effects by Ceunen et al. (2016). An immediately significant effect was also
found in that study.

5.4.2 Research question 11: Can an effect of the live and/or video testimonial
be observed one month after offering these testimonials to the
respondents?

The effects one month after the testimonials were only examined for attitude and
behavioral intention towards safety at railway crossing to determine whether the
previously found effects immediately after the testimonials also persisted in the
longer term. In other words, it is assumed that there are no effects on variables
with respect to traffic safety in general and on self-efficacy in the long term, not
for the live testimonial and not for the video testimonial.
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The results of the second post-test show that there is no lasting effect on attitudes
about safety at railway crossings for both the live and the video testimonial.
However, the live testimonial does have a significant positive effect on the
behavioral intention towards risky behavior at railway crossings that remains
stable after a month. Such an effect is not found for the video testimonial.

A longer-term effect on behavioral intention of students towards traffic safety in
general after a live testimonial is also found by Cuenen et al. (2016).

The lack of a lasting effect on attitudes towards safety at railway crossings is also
evident in Poulter & McKenna (2010) and Ceunen et al. (2016), although this
conclusion could only be made for female students in the latter study. A significant
long-term effect was found for male students. King et al. (2008) also found a
significant longer-term effect on attitudes. In Glendon et al. (2014) and Feenstra
et. al (2014), the counterintuitive effect is found that attitudes become less traffic
safety supportive in the longer term. However, Feenstra et al. (2014) also
introduces the relative attitude, where traffic safety is ranked among six other
health behaviors, such as "not smoking” and “not doing drugs”. This relative
attitude does experience a positive long-term effect of the live testimonial. It is
important to mention that for all of the above-mentioned studies, the “long term”
is defined slightly differently, ranging from 4 weeks to 6 months, which makes
comparing difficult.

As is the case for the immediate effect of testimonials, studies about the effect of
video testimonials are scarce or even non-existent. Studies on the effect of
testimonials on the longer-term were also not found for safety at railway
crossings.

The most important conclusion of the effect evaluation is that a live testimonial
can play a role in bringing about a lasting change in risky behavior of young people
at railway crossing. However, a video testimonial does not seem to be able to do
this.

As previously mentioned under 5.2.2, one of the possible explanations for the poor
effectiveness of the video testimonial is that the video format is less personal, with
greater distance between the speaker and the viewer of the video because there
is no direct contact.

However, the poor effectiveness of the video testimonial could also be due to its
quality. The process evaluation showed that the sound quality was not perceived
as good, and the videos looked less professional. This resulted in significant
differences in the cognitive and emotional impact between the live and video
testimonials. Significantly fewer students who watched the video testimonial found
it credible, useful, interesting, important, informative and shocking than students
who attended the live testimonial.
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With a limited budget and little experience, the three videos were recorded and
made available via YouTube in a short period of time. It is therefore not surprising
that the quality is lower and that the videos appear less professional. According
to Donovan et al. (1999), however, a low budget does not have to lead to a lesser
effect. Low cost talking heads testimonials of 30 seconds performed equally as
well as their far more expensive counterparts in this study on road safety
advertising.
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6 Limitations and future research

When designing and organizing the research and processing and analysing the
collected data, a number of limitations were encountered, leading to the need for
a cautious interpretation of the findings.

With regard to the testimonials, a lack of development time and available budget
might have caused the video testimonial to appear less professional as it could
have been when sufficient resources had been available.

The inexperience of the speaker with video testimonials, led to some notable
differences between the live and the video testimonial that might have influenced
the assessment of and the effect on respondents. More humor was used in the
live testimonial than in the video testimonial. Furthermore, in the video testimonial
no slides were used, in contrast with the live testimonial. However, most
importantly, the respondents indicated the sound was not clear and thus that the
speaker was not good comprehensible.

For this study, it was also decided upon that the live testimonial needed to be as
close to the ones that the speaker had done before in secondary schools across
the country, in order not to influence the possible results too much. The original
main message of the speaker’s testimonials is not per se traffic safety, but rather
“positivity”. The focus of the testimonial is also on the consequences, because the
cause of the accident is not clear, because of the loss of memory of the victim and
the lack of withesses. In the story that is told, the focus is on revalidation and the
life after and less on the life before (which might help in strengthening the
identification of the audience with the speaker) and the accident itself (which
might give the audience some valuable lessons on the behavioral elements that
need to be change).

It is worth to mention that the live testimonial took longer than planned.
Normally, there was only 30 minutes for the live testimonial, after which the
students would fill in the follow-up survey in class. Eventually, the testimonial took
almost a full class hour, which might have influenced the response rate, as
respondents had little time to complete the survey in class and had to take the
initiative to complete it in their own time. Furthermore, there was no more time
for students to ask the speaker some questions, which is normal in a live
testimonial environment and an advantage for live testimonials.

The combination of the application of convenience sampling for the experimental
group and the difficulty to find and convinced schools to cooperate to the study
for the control group, might have let to biases in the results. Many schools
indicated that the cooperation in a study can be burdensome (especially in a
longitudinal study), and most schools had other priorities at the time. This has led
to the fact that the experimental and control group were not well balanced.
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In the first post-test as well as in the second dataset there is a significantly higher
proportion of female students in the control group than in the experimental group.
There is also a significantly higher proportion of 3™ graders in the experimental
group than in the control group. Finally, there is a significantly lower proportion
of throughflow finality students and a significantly higher proportion of double
finality and labor market finality students in the control group than in the
experimental group.

There are also differences between the two schools when it comes to mobility
options (e.g. location of the school, presence of a train station, availability of bus
connections, ...), railway track density in the area and location of important
neighbouring residential zones in relation to the railway crossing(s) in the area;
leading to differences in main mode choice and exposure to railway crossings. This
might have had an influence on the results of the effect evaluation.

The loss of many cases in the process of merging the pre- and post-test data sets,
was already discussed in paragraph 3.6.3. Only 197 of a possible 343 cases could
be matched after the first post-test and only 77 of a possible 197 after the second
post-test. The problem seemed to lie with the uncareful reading of the questions
by the respondents and a number of actions were taken to detect some of the
errors and correct them. Apart from the merging process, a lot of cases were also
lost when a notable portion of the respondents of the experimental group
mistakenly answered that they were not presented a testimonial, probably
because of ambiguity of the specific question. The loss of a notable number of
cases led to smaller sample sizes for the analyses and might have led to less
significant results, for example in the process and effect evaluation.

Furthermore, an error was made in drawing up the answer categories for the scale
about the frequency of past behavior at railway crossings at the first post-test,
where the answer categories were incorrectly copied from the pre-test. The latter
asked about behavior in the past 6 months, while the first post-test asked about
behavior in the past week. The answer categories therefore did not correspond to
the period highlighted in the question. However, because the periods over which
past behavior was questioned differed between the different measurements, it was
in any case difficult to compare past behavior between the different
measurements.

Furthermore, there is the limitation of external validity of this study. The study
makes statements about a specific target group and the respondents were found
in a specific region with a rather limited density of the railway network. In addition,
there is an overrepresentation of female students in the sample.

The question therefore arises whether the results can be generalized or extended
to other target groups. However, one may also wonder whether the results would
have been the same with a different testimonial. After all, every testimonial is
unique.
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Finally, there is a chance that respondents have given socially desirable answers
to certain questions, which could, for example, give a more positive picture of past
behavior and behavioral intention. After all, crossing railway crossings when the
barriers are closed is a clearly illegal behavior and the questions are asked in a
school environment, which may cause students to fear that teachers or school
administrators will find out that they are engaging in certain illegal behavior,
despite the fact that anonymity was assured at the beginning of the survey.

The following suggestions for further research can be made:

With the data collected in this study: examine if the effectiveness of the
testimonials differs for different subgroups, using covariates on a MANCOVA
analysis for the effect evaluation of the first and second post test, such as
gender or grade.

It would be interesting to examine if the same conclusions on attitudes,
behavior(al intention), assessment and effects of testimonials apply to
people outside of the target group, for example first graders or elderly, and
for people in another geographical region.

It would also be interesting to examine if the same conclusions on attitudes,
behavior(al intention), assessment and effects of testimonials would apply
to other testimonials. Related to this matter, in a subsequent investigation,
a video testimonial can be made in a more professional and attractive way,
with more humor, images of the scene of the accident, of the victim before
the accident, in the hospital and during rehabilitation and videos of near-
accidents.

Finally, as this study only suggests that live testimonials have a (lasting)
effect on behavioral intentions, further research can be done the effect on
actual behavior at level crossings and on other possible interventions that
can improve behavior.
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7 Recommendations

The following recommendations can be made to speakers and other providers of
testimonials who want to promote safety at railway crossings and to school boards,
especially those of schools located near a railway crossing.

If it is not already done at this moment, it is recommended to start providing some
form of intervention that aims to change attitudes and behavioral intention at
railway crossings. After all, this study shows that many young people are exposed
to railway crossings, that many young people engage in unsafe behavior and that
unsafe behavior in the past is a good predictor of both the attitude towards unsafe
behavior at railway crossings and of future intentions to behave unsafely at railway
crossings.

When considering this type of interventions, it is advisable to consider testimonials
by victims, family members of victims, train drivers or other railway personnel.
Live testimonials are preferred to video testimonials, although video testimonials
can also be used to positively influence attitudes about unsafe behavior at railway
crossings. However, because there is no long-term effect, these videos should be
offered to the target group periodically.

When making video testimonials, attention needs to be pay attention to the quality
of the videos (sound, visibility, graphs, framing). It is preferable to work with a
professional production company. An attempt must also be made to make an
emotional impact on the young people.

Images can be shown, for example of the location where the accident happened,
of the victim at the hospital (or) during revalidation, but also of his or her life
before the accident to increase identifiability. The testimonial can also be
combined with footage of (near) accidents at railway crossings. This is also done
in the effect study of Poulter & McKenna (2010).

It is important to focus not only on interventions aimed at changing attitudes
about unsafe behavior at railway crossings, but also attitudes about road traffic
safety in general, as these are a good predictor of intention of risky behavior at
railway crossings.

While all students, regardless of gender, grade and study domain will benefit from
testimonials, it is recommended to start at a young age and focus on male
students. No distinctions need to be made between study domains.
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8 Conclusion

In the past, little research has been done into the effects of testimonials as an
instrument to reduce risky behavior at railway crossings, especially for video
testimonials. The large sample size (n=763) in the pre-test of this study allows
for an extensive measurement of behavior in traffic in general and at railway
crossings in particular among Flemish 2" and 3™ graders at secondary schools.

This measurement shows that young people are frequently exposed to railway
crossings and risky behavior is quite common, both in attitude, past behavior and
behavioral intention. This is even more the case for risky behaviors that cause
distraction, such as using a smartphone or wearing headphones while crossing a
railway crossing. There should be extra focus on male students and 2" graders,
as they are significantly less safe across the board.

The search for factors that predict attitudes and behavior at railway crossings
reveals that the most important predictors are attitude towards traffic safety in
general and past behavior at railway crossings, which is in line with what is found
in the literature. Socio-demographical variables are not good at predicting
attitudes, past behavior and behavioral intention at railway crossings, except for
grade (only for past behavior).

The process evaluation, in which participants evaluated the presented live and
video testimonials, shows that students clearly prefer live testimonials. They are
perceived as more credible, useful, interesting, important, informative, humorous
and shocking. The witness was also easier to understand. The video testimonial
had a significantly lower cognitive and emotional impact. Lack of time, budget and
experience might have led to a less professional video testimonial, which can be
seen as one of the main limitations for this study.

The effect evaluation shows that the live testimonial has an immediate positive
effect on both the attitude and the behavioral intention towards risky behavior at
railway crossings. Only the effect on behavioral intention remains after a month.
The video testimonial only has an immediate effect on attitude and not on
behavioral intention. After a month, there is no trace of the effect on attitude.

The most important limitations of this study are differences between the
experimental and control group on some important variables, the loss of quite
some data in the merging process and concerns about external validity of the
results and socially desirable answers. Further research is recommended. It is also
recommended to schools and testimonial providers to implement interventions to
reduce risky behavior of young people at railway crossings. Live testimonials are
definitely recommended, because they appear to have a lasting effect on
behavioral intention. It has not been proven that video testimonials have a similar
effect. Further research should demonstrate whether professional video
testimonials can achieve this.
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Annexe 1: Survey pre-test

Beste

Mijn naam is Ronald Wolfs en ik studeer Mobiliteitswetenschappen aan de
Universiteit Hasselt. In het kader van mijn masterproef voer ik een studie uit
naar het gedrag van jongeren nabij spooroverwegen. Een spooroverweg is een
kruising tussen een weg en een spoorlijn. Deze is bijna altijd uitgerust met
slagbomen, knipperlichten en een geluidssignaal (bel).

De deelname aan deze studie is vrijwillig en je hebt het recht om met de studie
te stoppen zonder een reden hiervoor op te geven. Je antwoorden zullen
anoniem verwerkt worden. Je hoef dus nergens je naam te schrijven. Op geen
enkel moment in de studie zal iemand weten welke antwoorden je gegeven hebt.
De resultaten van de studie zullen gedurende 2 jaar worden bijgehouden en na
deze periode verwijderd worden.

Het invullen van deze vragenlijst duurt slechts 15 minuten. Er zijn geen goede of
foute antwoorden, ik ben gewoon geinteresseerd in jouw eerlijke persoonlijke
mening. Indien er vragen zijn over situaties die niet op jou van toepassing zijn,
probeer je dan voor te stellen dat het wel op jou van toepassing is. Bijvoorbeeld:
indien de vraag over autorijden gaat en je rijdt nog niet met de auto, geef dan
alsnog je mening hierover.

Alvast bedankt!
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Q1 Gelieve eerst onderstaande in te vullen alvorens te starten met de
vragenlijst.

Vul hier de eerste twee letters van je voornaam in. Bijvoorbeeld: Bart -> BA

Vul hier de eerste twee letters van de voornaam van je moeder in.
Bijvoorbeeld: Sophie -> SO

Vul hier je geboortedag in. Bijvoorbeeld: 06

Vul hier je geboortemaand in. Bijvoorbeeld: Januari -> 01

Q2 Wat is je geslacht?

Mannelijk

Vrouwelijk
Non-binair/derde geslacht
Ik zeg dat liever niet

Q3 In welk jaar ben je geboren?

2004
2005
2006
2007
2008
2009
2010

Een ander jaar, namelijk:
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Q4 In welke school zit je?

Humaniora Kindsheid Jesu Hasselt

Atheneum Martinus Bilzen

Bovenbouw Sint-Michiel Leopoldsburg

WICO Campus Neerpelt

IKSO - Instituut voor Katholiek Secundair Onderwijs
Een andere school, namelijk:

Q5 In welke jaar zit je?

3de middelbaar
4de middelbaar
5de middelbaar
6de middelbaar
7de middelbaar

Een ander jaar, namelijk:

Q6 In welk studiedomein zit je?

Doorstroomfinaliteit (vroegere ASO)
Dubbele finaliteit (vroegere TSO en KSO)
Arbeidsmarktfinaliteit (vroegere BSO)
Weet ik niet
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Q7 Met welk vervoermiddel verplaats je je het vaakst van thuis naar school?
Gelieve slechts één bolletje aan te duiden. Als je bijvoorbeeld eerst met de fiets
naar de bushalte rijdt en dan de bus neemt, duidt dan het vervoermiddel aan
waarmee je het langst onderweg bent.

Te voet

Met de fiets

Met de bromfiets

Met de bus

Met de trein

Met de auto als passagier

Met de auto als bestuurder

Andere, namelijk:

Q8 Heb je een rijbewijs?

Nee
Ja, ik heb een voorlopig rijbewijs

Ja, ik heb een definitief rijbewijs

Deze vraag weergeven:
If Q8 = Ja, ik heb een voorlopig rijbewijs
Or Q8 = Ja, ik heb een definitief rijbewijs
Q9 Welk (voorlopig) rijbewijs bezit je? Je mag meerdere antwoorden aanduiden.
Categorie AM: bromfiets met een maximumsnelheid tussen 25 en 45 km/u
Categorie A: motorfietsen
Categorie B: wagens

Categorie G: landbouwvoertuigen
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Q10 Hoe vaak moet je op de weg van/naar school een spooroverweg
oversteken?

Nooit

Maximaal 1 keer per maand
Maximaal 1 keer per week
Meer dan 1 keer per week
Elke dag of bijna elke dag

Deze vraag weergeven:
If Q10 != Nooit

Q11 Met welk vervoermiddel moet je dan de spooroverweg oversteken? Je mag
meerdere antwoorden aanduiden.

Te voet

Met de fiets

Met de bromfiets

Met de bus

Met de auto als passagier
Met de auto als bestuurder

Andere, namelijk:

Q12 Hoe vaak moet je op andere momenten (bijv. voor een hobby) een
spooroverweg oversteken?

Nooit

Maximaal 1 keer per maand

Maximaal 1 keer per week

Meer dan 1 keer per week

Elke dag of bijna elke dag
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Deze vraag weergeven:
If Q12 != Nooit

Q13 Met welk vervoermiddel moet je dan de spooroverweg oversteken? Je mag
meerdere antwoorden aanduiden.

Te voet

Met de fiets

Met de bromfiets

Met de bus

Met de auto als passagier
Met de auto als bestuurder

Andere, namelijk:

Q14 Woon je in de buurt van een spooroverweg (binnen een straal van een
kilometer, maximum 15 minuten wandelen of 5 minuten fietsen) ?

Ja
Nee
Weet ik niet

Q15 Heb je al ooit een verkeersboete gekregen?

Nee, nog nooit
Ja, maar slechts één keer

Ja, al meerdere keren
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Deze vraag weergeven:

If Q15 != Nee, nog nooit

Q16 Waarvoor kreeg je al eens een boete? Je mag meerdere antwoorden
aanduiden.

Te snel rijden

Zonder handen fietsen

Sporen oversteken op een plaats waar dit niet mocht
De weg oversteken op een plaats waar dit niet mocht
Door het rode licht rijden of wandelen

Rijden onder invloed van alcohol of drugs

Een spoorweg oversteken wanneer de slagbomen niet volledig open waren en
de signalisatie actief was

Andere, namelijk:

Q17 Ben je al ooit betrokken geweest in een verkeersongeval?

Nee, nog nooit

Ja, 1 keer

Ja, 2 keer

Ja, meer dan 2 keer

113



Deze vraag weergeven:
If Q17 '= Nee, nog nooit

Q18 Waar vond dit verkeersongeval plaats? (meerdere antwoorden mogelijk
indien meer dan 1 verkeersongeval)

Op een rotonde

Op een wegsegment

Aan een spooroverweg

Op een kruispunt met verkeerlichten

Op een kruispunt zonder verkeerslichten

Andere, namelijk:
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Q19a Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Evenveel
Helemaal Eerder
) . mee eens Eerder Helemaal
niet mee niet mee .
als niet mee eens mee eens
eens eens
mee eens

Een fietshelm kan
ernstige
verwondingen
voorkomen.

Als ik me houd aan
verkeersregels voel
ik me veiliger.

Als je bij het
oversteken gebruik
maakt van een
zebrapad, heb je
minder snel een
verkeersongeval.

Als je een
fluorescerend
vestje draagt,

merken anderen je
sneller op.

Als ik voldoende
afstand houd
tijdens het fietsen,
kan ik beter
reageren op
onverwachte
gebeurtenissen.

Een fietshelm
dragen ziet er
belachelijk uit.

Een
veiligheidsgordel
dragen vind ik
nogal vervelend.
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Q19b Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Helemaal . Evenveel

niet mee Eerder niet mee e_ens Eerder Helemaal
mee eens als niet mee eens mee eens
mee eens

eens

Steeds opletten
voor anderen in het
verkeer is
vermoeiend.

Altijd de
verkeersregels
respecteren is saai.

Door een fietshelm
zie je het verkeer
rondom minder
goed.

Gewoon de straat
oversteken zonder
te kijken gaat
vlotter.

Muziek beluisteren
tijdens het fietsen
is best rustgevend.

Snel autorijden lijkt
me best spannend.

Snel rijden zorgt
ervoor dat je
vroeger op je

bestemming
geraakt.
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Q19c Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Evenveel
Helemaal Eerder
. . mee eens Eerder Helemaal
niet mee niet mee .
als niet mee eens mee eens
eens eens
mee eens

Naast elkaar
fietsen is leuker
dan achter elkaar.

Alcohol in het
verkeer is dom.

Als je telefoneert
tijdens het
fietsen, ben je
minder
aandachtig.

Door het rood
licht fietsen is
onverantwoord.

Meerijden met
iemand onder
invloed van drugs
is gevaarlijk.

Geen voorrang
geven is
egoistisch.

Snel fietsen geeft
een kick.
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Q19d Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Helemaal

Evenveel
niet mee Eerder niet mee eens Eerder Helemaal
cens mee eens als niet mee eens mee eens
mee eens
Als je
telefoneert
tijdens het
autorijden,
reageer je
trager.
Met de auto

door het rood
licht rijden is
levensgevaarlijk.

Mijn vrienden
dragen meestal
een helm tijdens

het fietsen.

De meeste
weggebruikers
houden zich aan
de
verkeersregels.
Mijn
leeftijdsgenoten
fietsen meestal
niet gevaarlijk of
agressief.

Ik vind dat je
altijd rekening
moet houden
met andere
weggebruikers.

In het verkeer
moet je geduld
kunnen hebben
met anderen.
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Q19e Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Evenveel
Helemaal Eerder
) ; mee eens Eerder Helemaal
niet mee niet mee .
als niet mee eens mee eens
eens eens
mee eens

Mijn vrienden vinden

dat je onder invloed

van alcohol niet mag
autorijden.

De meeste mensen
die ik ken vinden dat
je gebruik moet
maken van het
zebrapad om over te
steken.

De meeste
leeftijdsgenoten
vinden dat je een
fluorescerend vestje
moet dragen op de
fiets.

De meeste mensen
gebruiken hun
smartphone niet
tijdens het fietsen.

Mijn ouders vinden
het goed dat ik een
veiligheidsgordel
draag.

Volgens mijn
vrienden is fietsen
onder invloed van

alcohol dom.

Ik vind het helemaal
niet moeilijk om
rekening te houden
met andere
weggebruikers.
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Q19f Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Helemaal
niet mee
eens

Eerder niet
mee eens

Ik kan mij aan de
verkeersregels
houden, ook als

alle andere
weggebruikers dit
niet doen.

Veilig rijden is een
kwestie van
karakter. Wie
ervoor kiest, kan
het.

Als ik op stap ga
drink ik een
pintje, ook al
moet ik nog

fietsen.

Als ik gehaast
ben, gebeurt het
wel eens dat ik te

snel rijd.

Als ik plots hard
moet remmen, is
dit meestal de
schuld van
iemand anders.

Als ik op een
kruispunt geen
ander verkeer zie,
dan rijd ik bij
oranje gewoon
door.

Als alle andere
voetgangers
oversteken bij een
rood licht, blijf ik
niet als enige
staan.
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Q19g Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Evenveel
Helemaal Eerder
. . mee eens Eerder Helemaal
niet mee niet mee .
als niet mee eens mee eens
eens eens
mee eens

Als ik naar de
winkel om de hoek
ga, vind ik een
veiligheidsgordel
niet nodig.

Als ik met mijn
vrienden wegga,
zet ik liever geen

fietshelm op.

Als je met de auto

op stap gaat kan

een pintje of twee
geen kwaad.

Ik ben van plan
om in de toekomst
mijn helm op te
zetten als ik fiets.

Ik ben van plan
om me in de
toekomst aan de
verkeersregels te
houden.

Ik ben van plan
om in de toekomst
rekening te
houden met
andere
weggebruikers.

Ik ben van plan
om in de toekomst
niet sneller te
rijden dan
toegestaan.
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Q19h Hieronder vind je enkele uitspraken over verkeersveiligheid. Duid het
antwoord aan dat het best overeenkomt met jouw mening.

Evenveel
Helemaal Eerder
. ; mee eens Eerder Helemaal
niet mee niet mee .
als niet mee eens mee eens
eens eens
mee eens

Ik ben van plan
om in de toekomst
mijn
veiligheidsgordel
te dragen.

Op de fiets zet ik
meestal mijn helm

op.

Ik houd me
meestal wel aan
de verkeersregels.

In het verkeer
houd ik meestal
rekening met
andere
weggebruikers.

Ik rijd meestal niet
sneller dan
toegestaan.

Ik draag meestal
mijn
veiligheidsgordel.
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Q20 Kan je voor elk van de gedragingen in de volgende lijst aangeven in welke

mate je dit type gedrag gevaarlijk vindt?

He'nei?taa' Niet echt
gevaarlijk gevaarlijk

Een spooroverweg
oversteken wanneer
de rode lichten
knipperen en de
slagbomen volledig
dicht zijn

Een spooroverweg
oversteken zonder
goed naar de
signalisatie gekeken te
hebben

Een spooroverweg
oversteken wanneer
het zicht beperkt is
door slechte
weersomstandigheden
(bvb. door mist of
regen)

Een spooroverweg
oversteken wanneer
de rode lichten
knipperen, maar
voordat de slagbomen
volledig dicht zijn

Een spooroverweg
oversteken wanneer er
net een trein
gepasseerd is, maar
voordat de slagbomen
volledig open zijn en
de rode lichten nog
knipperen

Een spooroverweg
oversteken wanneer
het gehoor verhinderd
is (bvb. door het
luisteren naar muziek
via een hoofdtelefoon)

Een spooroverweg
oversteken terwijl je
op je smartphone
bezig bent
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Q21 Hoe waarschijnlijk is het dat je volgende gedragingen in de toekomst zal

doen?

Onwaar-
schijnlijk

Zeer on-
waarschijnlijk

Een spooroverweg
oversteken wanneer
de rode lichten
knipperen en de
slagbomen volledig
dicht zijn

Een spooroverweg
oversteken zonder
goed naar de
signalisatie gekeken
te hebben

Een spooroverweg
oversteken wanneer
het zicht beperkt is
door slechte
weersomstandigheden
(bvb. door mist of
regen)

Een spooroverweg
oversteken wanneer
de rode lichten
knipperen, maar
voordat de slagbomen
volledig dicht zijn

Een spooroverweg
oversteken wanneer
er net een trein
gepasseerd is, maar
voordat de slagbomen
volledig open zijn en
de rode lichten nog
knipperen

Een spooroverweg
oversteken wanneer
het gehoor verhinderd
is (bvb. door het
luisteren naar muziek
via een
hoofdtelefoon)

Een spooroverweg
oversteken terwijl je
op je smartphone
bezig bent
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Q22 Hoe vaak heb je in de afgelopen 6 maanden volgende gedragingen gesteld?

. . . Meer
Maximaal 1 Maximaal 1 Maximaal 1
Zelden dan 1
. keer per 2 keer per keer per
tot nooit keer per
maanden maand week week

Een spooroverweg
oversteken wanneer
de rode lichten
knipperen en de
slagbomen volledig
dicht zijn

Een spooroverweg
oversteken zonder
goed naar de
signalisatie gekeken
te hebben

Een spooroverweg
oversteken wanneer
het zicht beperkt is
door slechte
weersomstandigheden
(bvb. door mist of
regen)

Een spooroverweg
oversteken wanneer
de rode lichten
knipperen, maar
voordat de slagbomen
volledig dicht zijn

Een spooroverweg
oversteken wanneer
er net een trein
gepasseerd is, maar
voordat de slagbomen
volledig open zijn en
de rode lichten nog
knipperen

Een spooroverweg
oversteken wanneer
het gehoor verhinderd
is (bvb. door het
luisteren naar muziek
via een
hoofdtelefoon)

Een spooroverweg
oversteken terwijl je
op je smartphone
bezig bent
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Q23 Vergeleken met je leeftijdsgenoten van hetzelfde geslacht, hoe scoor je
volgens jou op de volgende vaardigheden?

Verkeersregels
aan
spooroverwegen
correct
toepassen

Inzicht in
verkeerssituaties
aan
spooroverwegen

Kennis van de
verkeersregels
aan
spooroverwegen

Weerstaan aan
groepsdruk

Weerstand
bieden aan de
verleiding tot

risicovol gedrag

Veel

slechter Slechter
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Annexe 2: Additional questions for process evaluation

Q4 Woonde je onlangs op school een getuigenis bij van een slachtoffer van een
verkeersongeval met een trein?

Ja

Nee

Deze vraag weergeven:
If Q4 = Ja

Q5 Woonde je deze getuigenis bij in de vorm van een lezing in het auditorium of
in de vorm van korte video's?

In de vorm van een lezing in het auditorium
In de vorm van korte video's

Geen van beide, maar:

Deze vraag weergeven:
If Q5 = In de vorm van korte video's

Q6 Welke video's van deze getuigenis heb je gezien? Er zijn meerdere
antwoorden mogelijk.

De eerste, met de schets van het ongeval

De tweede, over de tijd in het ziekenhuis en de revalidatie
De derde, over het leven na de revalidatie

Geen van de drie

Ik weet het niet
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Deze vraag weergeven:
If Q5 = In de vorm van een lezing in het auditorium

Q7 Duid aan in hoeverre je het eens bent met onderstaande stellingen over de
getuigenis

Evenveel
Eerder Helemaal
Helemaal Eerder mee eens . )
: niet mee niet mee
mee eens mee eens als niet
eens eens
mee eens
Ik vond het
verhaal van de
getuige

geloofwaardig.

Ik vond het
verhaal van de
getuige nuttig.

Ik vond het
verhaal van de
getuige
interessant.

Ik vond het
verhaal van de
getuige
belangrijk.

Ik vond het
verhaal van de
getuige
informatief.

Ik vond het
verhaal van de
getuige
schokkend.

Ik zou de
getuigenis liever
via video hebben
gevolgd dan live.
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Deze vraag weergeven:
If Q5 = In de vorm van korte video's

Q8 Duid aan in hoeverre je het eens bent met onderstaande stellingen over de
getuigenis

Evenveel
Eerder Helemaal
Helemaal Eerder mee eens . )
: niet mee niet mee
mee eens mee eens als niet
eens eens
mee eens
Ik vond het
verhaal van de
getuige

geloofwaardig.

Ik vond het
verhaal van de
getuige nuttig.

Ik vond het
verhaal van de
getuige
interessant.

Ik vond het
verhaal van de
getuige
belangrijk.

Ik vond het
verhaal van de
getuige
informatief.

Ik vond het
verhaal van de
getuige
schokkend.

Ik zou de
getuigenis liever
live hebben
bijgewoond dan
via video's.
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Deze vraag weergeven:

If Q4 = Ja

Q9 Duid aan in hoeverre je het eens bent met onderstaande stellingen over de

getuigenis

Helemaal
mee eens

Ik vond het
verhaal van de
getuige
onrustwekkend.

Ik vond het
verhaal van de
getuige
beangstigend.

Ik vond deze
getuigenis eerder
schokkend dan
leerrijk.

Ik vond de
getuige zeer
goed.

Ik vond de
getuige duidelijk
en goed
verstaanbaar.

Eerder
mee eens
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Deze vraag weergeven:
If Q5 = In de vorm van een lezing in het auditorium
Q10 Wat vond je van de duurtijd van de getuigenis?
Ik vond de duurtijd van ongeveer 30 minuten oké
Ik vond de duurtijd van ongeveer 30 minuten te lang

Ik vond de duurtijd van ongeveer 30 minuten te kort

Deze vraag weergeven:
If Q5 = In de vorm van korte video's
Q11 Wat vond je van de duurtijd van de getuigenis?
Ik vond de duurtijd van 3 keer ongeveer 10 minuten oké
Ik vond de duurtijd van 3 keer ongeveer 10 minuten te lang

Ik vond de duurtijd van 3 keer ongeveer 10 minuten te kort

Deze vraag weergeven:

If Q4 = Ja

Q12 Wat is je het meest bijgebleven van de getuigenis?

Deze vraag weergeven:

If Q4 = Ja

Q13 Wat zou je toevoegen/aanpassen aan deze getuigenis?
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Annexe 3: Letter of consent for parents

Informatiebrief studie over risicogedrag aan
spooroverwegen

Beste ouder

Mijn naam is Ronald Wolfs en ik studeer Mobiliteitswetenschappen aan de Universiteit
Hasselt. In het kader van mijn masterproef voer ik een studie uit naar het gedrag van
jongeren van 15 tot 18 jaar nabij spooroverwegen. Risicogedrag in de buurt van
overwegen is een groot probleem in Belgié. Volgens de gegevens van Infrabel, verloren
tussen 2012 en 2022 55 mensen het leven en raakten 41 ernstig gewond bij 6.858
overwegincidenten. Naast de fysieke en mentale impact op de slachtoffers, hun families,
vrienden en het spoorwegpersoneel, zijn overwegincidenten ook de oorzaak van
aanzienlijke vertragingen op het Belgische spoorwegnet.

Het doel van deze studie is dan ook om te achterhalen hoe het risicogedrag aan
spooroverwegen kan verminderd worden. Dit gebeurt aan de hand van de getuigenis van
een slachtoffer van een ongeval met een trein. Daarnaast zullen de deelnemers zowel
voor als na de getuigenis een vragenlijst invullen over hun attitudes met betrekking tot
risicogedrag aan spooroverwegen en hun eigen gedrag in deze omgeving.

Weet dat bij toestemming:

- de deelname van uw kind vrijwillig is en uw kind het recht heeft om met het onderzoek
te stoppen zonder een reden hiervoor op te geven.

- de anonieme resultaten van deze test gedurende 2 jaar worden bijgehouden en na
deze periode verwijderd zullen worden.

- indien u vragen heeft, contact kan opnemen via ronald.wolfs@student.uhasselt.be.

- voor eventuele klachten of andere bezorgdheden omtrent de verwerking van
persoonsgegevens u contact kan opnemen met de functionaris voor
gegevensbescherming/data protection officer van de UHasselt: dpo@uhasselt.be

Indien u toch niet wenst dat uw kind zal deelnemen aan deze studie, dan kan u een mail
sturen naar ronald.wolfs@student.uhasselt.be. Er wordt dan zeker met uw bezorgdheden
rekening gehouden.?

Met vriendelijke groet,
Ronald Wolfs

Student Master Mobiliteitswetenschappen UHasselt
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